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LIMITED WARRANTY AND LIMITATION OF LIABILITY 
 

IMO Precision Controls Ltd ("IMO") warrants to the original purchaser that the i³D Lite module manufactured by IMO is free from 
defects in material and workmanship under normal use and service. The obligation of IMO under this warranty shall be limited to 
the repair or exchange of any part or parts which may prove defective under normal use and service within three (3) years from 
the date of manufacture, such defect to be disclosed to the satisfaction of IMO after examination by IMO of the allegedly defective 
part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL OTHER OBLIGATIONS OR 
LIABILITIES AND IMO NEITHER ASSUMES, NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IMO, ANY OTHER 
LIABILITY IN CONNECTION WITH THE SALE OF THIS i³D Lite module. THIS WARRANTY SHALL NOT APPLY TO THIS i³C 
Lite module OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, 
OR MISUSE. IMO MAKES NO WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY 
IMO. THE TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON 
FOR WHOM THE i³D Lite module IS ORIGINALLY INSTALLED. THIS WARRANTY SHALL APPLY ONLY WITHIN THE 
BOUNDARIES OF THE CONTINENTAL UNITED STATES. In no event, whether as a result of breach of contract, warranty, tort 
(including negligence) or otherwise, shall IMO or its suppliers be liable of any special, consequential, incidental or penal damages 
including, but not limited to, loss of profit or revenues, loss of use of the products or any associated equipment, damage to 
associated equipment, cost of capital, cost of substitute products, facilities, services or replacement power, down time costs, or 
claims of original purchaser's customers for such damages. To obtain warranty service, return the product to your distributor with 
a description of the problem, proof of purchase, postpaid, insured, and in a suitable package. ABOUT PROGRAMMING EXAMPLE 
Any example programs and program segments in this manual or provided on accompanying diskettes are included solely for 
illustrative purposes. Due to the many variables and requirements associated with any installation, IMO cannot assume 
responsibility or liability for actual use based on the examples and diagrams. It is the sole responsibility of the system designer 
utilizing the i³D Lite module to appropriately design the end system, to appropriately integrate the i³D Lite module and to make 
safety provisions for the end equipment as is usual and customary in industrial applications as defined in any codes or standards 
which apply. NOTE: The programming examples shown in this manual are for illustrative purposes only. Proper machine operation 
is the sole responsibility of the system integrator. 
 
 
NOTE: The programming examples shown in this manual are for illustrative purposes only. Proper machine 
operation is the sole responsibility of the system integrator. 

  



 

 

PREFACE 
 
 
This manual explains how to use the i³D Lite. No part of this publication may be reproduced, transmitted, transcribed, 
stored in a retrieval system, or translated into any language or computer language, in any form by any means, electronic, 
mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior agreement and written permission of 
IMO. All software described in this document or media is also copyrighted material subject to the terms and conditions of 
the IMO Software License Agreement. Information in this document is subject to change without notice and does not 
represent a commitment on the part of IMO.  
 
Ethernet™ is a trademark of Xerox Corporation. microSD™ and CompactFlash are registered trademarks of SanDisk 
Corporation. 
 
 For user manual updates, contact Technical Support: 
 
Tel: +44 (0) 1707 414 444  
 
Website: http://www.imopc.com 
 
 Email: automation@imopc.com 
 
 
  

http://www.imopc.com/
mailto:automation@imopc.com
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Safety and Compliance 
Warnings 

 
When found on the product, the following symbols specify:  
 
 
 

  

Warning: Consult user documentation. Warning: Electrical Shock Hazard. 

WARNING – EXPLOSION HAZARD: Do not disconnect equipment unless power has been 
switched off or the area is known to be non-hazardous. 
 
WARNING: To avoid the risk of electric shock or burns, always connect the safety (or earth) 
ground before making any other connections.  
 
WARNING: To reduce the risk of fire, electrical shock, or physical injury it is strongly 
recommended to fuse the voltage measurement inputs. Be sure to locate fuses as close to 
the source as possible. 
 
WARNING: Replace fuse with the same type and rating to provide protection against risk of 
fire and shock hazards.   
 
WARNING: In the event of repeated failure, do not replace the fuse again as a repeated 
failure indicates a defective condition that will not clear by replacing the fuse.  
 
WARNING: EXPLOSION HAZARD—Substitution of components may impair suitability for 
Class I, Division 2. 
 
WARNING: The USB parts are for operational maintenance only. Do not leave permanently 
connected unless area is known to be non-hazardous. 
 
WARNING: EXPLOSION HAZARD—BATTERIES MUST ONLY BE CHANGED IN AN 
AREA KNOWN TO BE NON-HAZARDOUS 
 
WARNING: BATTERY MAY EXPLODE IF MISTREATED. DO NOT RECHARD, 
DISASSEMBLE, OR DISPOSE OF IN FIRE. 
 
WARNING: Only qualified electrical personnel familiar with the construction and operation of 
this equipment and the hazards involved should install, adjust, operate, or service this 
equipment. Read and understand this manual and other applicable manual in their entirety 
before proceeding. Failure to observe this precaution could result in severe bodily injury or 
loss of life. 
 
WARNING: If the equipment is used in a manner not specified by IMO, the protection 
provided by the equipment may be impaired. 
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Intro to the I3DL 
Visual Overview 11 
Where to find more information for the I3DL 12 
Connectivity to the I3DL 12 
Features of I3DL Controller 13 

Visual Overview 
Touch Screen - Press upper right corner to bring out the function keys and SYSTEM key 
to access the Main Menu. 

1. Touchscreen
2. High-capacity microSD Slot
3. RS232/RS485 Serial Connector, CAN port (via RJ45),

LAN Port (Ethernet)
4. USB Mini-B Port
5. Analog I/O, DC Inputs, DC Outputs
6. DC Power

NOTE: See "Precautions" on page 1 about USB and grounding. 
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Where to find more information for the I3DL 

Datasheet - The datasheet is the first document to refer to for key information related to specific models. (A basic 
datasheet is provided in the box with the unit.)  

Features of I3DL Controller 
The I3DL are all-in-one industrial control devices. They combine control, user interface, I/O and networking into a 
single, integrated package. Unique features of the i3DL include the following. 

1. Small, sleek profile saves space and resources.
2. Physical Specifications

l mm: 167.818 tall x 264.998 wide x 52.07 deep
l in: 6.607 tall x 10.4333 wide x 2.05 deep
l 39 oz. / 1105.6g

3. Bright color display
4. Display of complex graphical objects including trends, gauges, meters and animations
5. Advanced control capabilities including floating point, multiple auto-tuning PID loops and string handling cap- 

abilities.
6. Intuitive interface
7. Removable media for storage of programs, data logging, or screen captures
8. iCAN networking port for communication with remote I/O, other controllers or PCs
9. i3 Configurator programming software that allows all aspects of the I3DL to be programmed and configured

from one integrated application.
10. Fail – Safe System which allows an application to continue running in the event of “Soft” failures such as (Bat- 

tery power loss or Battery Backed register RAM / Application flash corruption)
11. Clone Unit allows the user to “clone” the i3. This feature “clones” application program and unit settings

stored in Battery backed RAM of an i3. It can then be used to clone a different i3s (but must be the exact
same model).

12. Suited for most applications across a diverse range of industries.



Mechanical Installation 

6 

Mechanical 
Installation 



Mechanical Installation 

 

7 
 

Mechanical Installation 
 

Mounting Overview 15 
Mounting Procedures (Installed in a Panel Door) 15 
Mounting Clip Locations 16 
Dimensions 17 
Installation Procedure 18 
Factors Affecting Panel Layout Design and Clearances 18 

 

NOTE: The datasheet is the first document to refer to for model-specific information related to i3EL models and key 
installation information. Visit the IMO websites to obtain datasheets, user documentation, and updates. 

 
Mounting Overview 

Mechanical installation greatly affects the operation, safety, and appearance of the system. Information is 
provided to mechanically install the unit such as cut-out sizes, mounting procedures, and other recommendations 
for the proper mechanical installation of the unit. 

 
 

Mounting Procedures (Installed in a Panel Door) 
Once the panel design has been completed using the criteria and suggestions in the following sections, use the 
following steps to panel mount the i3DL. 

 
NOTE: Unit comes with composite clips, which are tested for typical wash down, shock, and vibration. If metal 
mounting clips are needed, they can be ordered at the IMO Automation website. 

 
1. Carefully locate an appropriate place to mount the i3DL. Be sure to leave enough room at the top of the 

unit for insertion. Remove the microSD card to prevent damage to the panel edge. 
2. Carefully cut the host panel per the measurements found in the datasheet. Dimensions can also 

be found below in the Panel Cutout section. If the opening is too large, water may leak into the enclosure, 
potentially damaging the unit. If the opening is too small, the i3 may not fit through the hole without dam- age. 

3. Remove any burrs and/or shape edges and ensure the panel is not warped in the cutting process. 
4. Make sure the gasket is installed on the I3DL and is free from dust and debris. Check that the corners of the 

gasket are secure. 
5. Pass the unit through the panel. 
6. Insert each of the four (4) mounting clips into the slots in the I3DL case. One composite plastic clip 

should be installed on each corner. Lightly tighten each screw so the clip is held in place. 
 

7. Tighten the screws on the clips such that the gasket is compressed against the panel. Recommended torque 
is 2-3 in-lbs (0.23 – 0.34 Nm). If metal mounting clips are used in place of the plastic composite mounting 
clips, the recommended torque is 4-8 in-lbs (0.45-0.90 Nm). 

8. Connect communications cables to the serial port, USB ports, and CAN port as required. 
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Mounting Clip Locations 

I3DL Mounting Orientation 

NOTE—For panel or DIN rail mounting: The orientation shown above provides for optimum readability of the 
screen and ease of use of the keypad. 
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Dimensions 
For installations requiring NEMA 4X liquid and dust protection, the panel cutout should be cut with a tolerance of 
+ / - 1mm.

Installation Procedure 
l This equipment is panel mounted and is meant to be installed in an enclosure suitable for the environment,

such that the back of the equipment is only accessible with the use of a tool.
l This equipment is suitable for use in Class I, Division 2, Groups A, B, C and D; Class II, Division 2 Groups F

and G; and Class III Hazardous Locations or Non-Hazardous Locations only.
l The i3DL utilizes a clip installation method to ensure a robust and watertight seal to the enclosure. Follow

the steps below for the proper installation and operation of the unit.

1. Carefully locate an appropriate place to mount the i3DL. Be sure to leave enough room at the top of the
unit for insertion and removal of the microSD™ card.

2. Carefully cut the host panel per the diagram, creating a 175mm x 131.9mm (with a tolerance of +/- 1.0mm)
opening into which the I3DL is to be installed. If the opening is too large, water may leak into the enclosure,
potentially damaging the unit. If the opening is too small, the I3  may not fit through the hole without dam- 
age.

3. Remove any burrs/sharp edges and ensure the panel is not warped in the cutting process.
4. Install and tighten the four mounting clips (provided in the box) until the gasket forms a tight seal. For stand- 

ard composite mounting clips (included with product). NOTE: Torque Rating is 2-3 in-lbs (0.23-0.34 Nm). For
optional metal mounting clips, use a torque rating of 4-8 in-lbs (0.45-0.90 Nm).

5. Connect communications cables to the serial port, USB ports, and CAN port as required.

Factors Affecting Panel Layout Design and Clearances 
WARNING: It is important to follow the requirements of the panel manufacture and to follow all applicable electrical 
codes and standards. 
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The designer of a panel layout must assess the requirements of a particular system and to consider the following 
design factors. 

 
 

Clearance / Adequate Space 
 

Install devices to allow sufficient clearance to open and close the panel door. 
 

Minimum Clearance Requirements for Panel Box and Door 
Minimum Distance between base of device and sides of cabinet 2” (50.80mm) 
Minimum Distance between base of device and wiring ducts 1.5” (38.10mm) 
If more than one device installed in panel box (or on door): 
Minimum Distance between bases of each device 

4” (101.60mm) between bases of each 
device 

When door is closed: 
Minimum distance between device and closed door 
(Be sure to allow enough depth for the I3 .) 

 
2” (50.80mm) 
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Grounding 
Panel Box: The panel box must be properly connected to earth ground to provide a good common ground reference. 
Panel Door: Tie a low impedance ground strap between the panel box and the panel door to ensure that they have 
the same ground reference. 

 
WARNING: Be sure meet the ground requirements of the panel manufacturer and also meet applicable electrical 
codes and standards. 

 
 

Temperature / Ventilation 
Ensure that the panel layout design allows for adequate ventilation and maintains the specified ambient 
temperature range. Consider the impact on the design of the panel layout if operating at the extreme ends of the 
ambient temperature range. For example, if it is determined that a cooling device is required, allow adequate space 
and clearances for the device in the panel box or on the panel door. 

 
 

Noise 
Consider the impact on the panel layout design and clearance requirements if noise suppression devices are needed. 
Be sure to maintain an adequate distance between the I3  and noisy devices such as relays, motor starters, etc. 

 
 

Shock and Vibration 
The I3  has been designed to operate in typical industrial environments that may inflict some shock and vibration on 
the unit. For applications that may inflict excessive shock and vibration please use proper dampening techniques or 
relocate the I3  to a location that minimizes shock and/or vibration. 

 
 

Panel Layout Design and Clearance Checklist 
The following list provides highlights of panel layout design factors: 

n Meets the electrical code and applicable standards for proper grounding, etc.? 
n Meets the panel manufacturer’s requirements for grounding, etc.? 
n Is the panel box properly connected to earth ground? Is the panel door properly grounded? Has the appro- 

priate procedure been followed to properly ground the devices in the panel box and on the panel door? 
n Are minimum clearance requirements met? Can the panel door be easily opened and closed? Is there 

adequate space between device bases as well as the sides of the panel and wiring ducts? 
n Is the panel box deep enough to accommodate the controller? 
n Is there adequate ventilation? Is the ambient temperature range maintained? Are cooling or heating devices 

required? 
n Are noise suppression devices or isolation transformers required? Is there adequate distance between the 

base of the controller and noisy devices such as relays or motor starters? Ensure that power and signal wires 
are not routed in the same conduit. 

n Are there other requirements that impact the particular system, which need to be considered? 
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Electrical Installation 
 

Ground Specifications 21 
How to Test for Good Ground 21 
Primary Power Port 22 

 
 

NOTE: The datasheet is the first document to refer to for model-specific information. Refer to IMO website. 

 
Ground Specifications 
Ideally, a ground resistance measurement from equipment to earth ground is 0Ω. In reality it typically is higher. The 
US National Electrical Code (NEC) states the resistance to ground shall not exceed 25Ω. IMO Automation 
recommends less than 15Ω resistance from the equipment to ground. Resistance greater than 25Ω can cause 
undesirable or harmful interference to the device. 

 
Grounding Definition - The term Ground is defined as a conductive connection between a circuit or piece of 
equipment and the earth. Grounds are fundamentally used to protect an application from harmful interference 
causing either physical damage such as by lightning or voltage transients or from circuit disruption often caused by 
radio frequency interference (RFI). 

 
How to Test for Good Ground 
To test ground resistance, a Ground Resistance Tester must be used. A typical Ground Resistance Meter Kit 
contains a meter, two or three wire leads, and two ground rods. Instructions are supplied for either a two-point or a 
three-point ground test. The figure shows a two-point ground connection test. 
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Primary Power Port 
NOTE: The Primary Power Range is 10VDC to 30VDC. 

Primary Power Port Pins 
PIN Signal Description 
1 Ground Frame Ground 
2 DC- Input Power Supply Ground 
3 DC+ Input Power Supply Voltage 

DC Input / Frame 
l Solid/Stranded Wire: 12-24 awg (2.5-0.2mm)
l Strip length: 0.28” (7mm)
l Torque, Terminal Hold-Down Screws: 4.5 – 7 in-lbs (0.50 – 0.78 N-m)
l DC- is internally connected to I/O V- but is isolated from CAN V-. A Class 2 power supply must be used.

Power Up 
1. OPTION: Attach ferrite core with a minimum of two turns of the DC+ and DC- signals from the DC supply that

is powering the controllers.

2. Connect to earth ground.
3. Apply recommended power.
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System Settings and Adjustments 
 

I3  LED Indicator Lights 24 
System Menu 25 
Set Networks & Set Network Baud Rate 27 
View Status & Diags 29 
View Protocols 31 
Set Keys, Serial Ports, Time/Date, Beeper & Screen 32 
Removable Media 37 
Calibrate Analog 38 
Fail – Safe System 39 
Clone Unit 42 
RMI License Details 45 
Touch Screen Calibration 46 

 
I3  LED Indicator Lights 
The i3DL has a built-in System Menu, which lets the user view System Settings and adjusts. To start the System Menu, 
press the SYSTEM key (or set %SR3 to 1), which will display the Main Menu. Then use the 
↑ and ↓ (Up Arrow or Down Arrow) keys to select a Main Menu item and press Enter (Return Arrow) to display the 
item’s Sub-Menu. 

 
NOTE: Press the upper right corner to bring out the function keys and SYSTEM key to access the Main Menu. 

 

 
 

 I3 LEDs 

 
RUN 

n OFF indicates i3  is in IDLE/STOP mode. 
n Flashing indicates DO / IO mode or RUN with no ladder program. 
n ON indicates ladder code running. 

 
OK 

n OFF indicates one or more self-tests failed. 
n ON indicates all self-tests passed. 
n Flashing at 1 Hz indicates forcing is active. 
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5.1 System Menu – Details 
 

The following sections describe each of the Sub-Menus in detail. 
 

Set Networks 
This sub menu allows setting for the CAN and Ethernet network to be viewed or changed. 

 

 
 

CAN, Ok? Yes= CAN connected to a CAN network and functioning properly 
No= Not ready to communicate on CAN network 

CAN ID 1 to 253 = This node’s ICAN Network ID; must be unique on network 

CAN Baud 125kB = 125kBd CAN network 
250kB = 250kBd CAN network 

500kB = 500kBd CAN network 
1MB = 1MBd CAN network 

MAC ID Displays the Ethernet MAC ID of the unit 
IP Displays the Ethernet IP address of the unit 
NetM Displays the Ethernet net mask of the unit 
GatWy Displays the Ethernet gateway of the unit 

 
NOTE: The IP address, Net Mask, and Gateway can be changed from the System Menu. This is designed 
for commissioning or temporary field changes. The actual parameters are defined in I3 configurator under 
the Ethernet configuration and are reverted to whenever the unit goes from idle to run mode. 
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Navigation and Editing 

As mentioned above, the System Menu is started by pressing the System key on the I3DL. Next press ESC to exit 
the System Menu, or use ↑ and ↓ to select an item and press the Enter key to display the item’s Sub-Menu. 

 
A Sub-Menu generally shows a list of System Settings and their values. After opening a Sub-Menu, if any of its 
System Settings are editable, the first System Setting that can be edited is highlighted. If desired, the↑ and ↓ keys 
can be used to select a different System Setting to be edited. 

 
At this point, either press ESC to exit the Sub-Menu (returning to the Main Menu) or press Enter to edit the high- 
lighted System Setting. If Enter is pressed, the System Setting’s value will be highlighted, indicating that it is ready 
to be modified. 

 
When modifying a System Setting’s value, use either the arrow keys ( ↓↑ → ← ) or the numeric keys, or the 
appropriate touch screen icons to select a new value. 

 
The arrow keys are used to edit System Settings that have just a few possible values. Each time the arrow key is 
pressed, a new possible value is displayed. When the desired value appears, press the Enter key to save it; 
otherwise press the ESC key to cancel the edit. 

 
The numeric keys are normally used to enter numeric System Settings. 

 
In addition, to edit a single numeric digit, use the → or ← key to select the digit and then either press a numeric key or 
use ↓ or ↑ to modify the digit. In any case, after entering the new desired value, press the Enter key to save it; oth erwise 
press the ESC key to cancel the edit. 
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Set Networks & Set Network Baud Rate 
Set Networks 

 
This sub menu allows setting for the CAN and Ethernet network to be viewed or changed. 

 
Network, Ok? Yes = connected to a network and functioning properly 

No = Not ready to communicate on the network 
Network ID 1 to 253 = This node’s iCAN Network ID; must be unique on network 

CAN Termination Yes = 121Ω termination is internally placed between CAN_H and CAN_L terminals 
No = No termination present 

MAC ID Displays the Ethernet MAC ID of the unit 
IP Address Displays the Ethernet IP address of the unit 
Network Mask Displays the Ethernet net mask of the unit 
Gateway Displays the Ethernet gateway of the unit 

 
NOTE: The IP address, Net Mask, and Gateway can be changed from the System Menu. This is designed for com- 
missioning or temporary field changes. The actual parameters are defined in software under the Ethernet con- 
figuration. 
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Set Network Baud Rate 
 

 
The Set Network Baud Sub-Menu for both I3DL models displays just one System Setting and it is editable. 

 
125kB = 125kBd CAN network 
250kB = 250kBd CAN network 
500kB = 500kBd CAN network 
1MB = 1MBd CAN network 

 
Network Baud 
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View Status & Diags 
View Status 

 
 

The View Status Sub-Menu displays up to 18 System Settings. Only the Mode System Setting is editable. 
 

 
Model 

Xxyyz = 5- or 6-character model number of this I3DL 
unit x is 1 for models that have a CAN port; 0 = no CAN 
port yy indicates the installed I/O module; 00 = no I/O 
module 
z indicates the installed COM module; N = no COM module 

 
Mode 

Idle = I3DL is in Idle mode 
DoIO = I3DL is in Do I/O 
mode Run = I3DL is in Run 
mode 

Scan Rate(mS) 0.0 = I3DL is not in Run mode 
0.1 to 999.9 = Average number of mS for each ladder scan 

Lcl Net Use % 0.0 to 100.0 = CAN network bandwidth % used by this I3DL node 
All Net Use % 0.0 to 100.0 = CAN network bandwidth % used by all nodes 
Ladder Size 2 (Number of bytes in application ladder program) 
Config Size 8 (Number of bytes in application I/O configuration) 
Graphics Size 8 (Number of bytes in application graphic screens) 
String Size 8 (Number of bytes in application string table) 
Bitmap Size 8 (Number of bytes in application bitmaps) 
Text Tbl Size 8 (Number of bytes in application text tables) 
Font Tbl Size 8 (Number of bytes in application font tables) 
Protocol Size 8 (Number of bytes in application downloaded protocols) 
SMS Msg Size 8 (Number of bytes in application SMS protocol configuration) 
Firmware Re: 14.18 (xx.yy of current firmware version) 
BIOS Rev 0.22 (Basic I/O System) 
CPLD Rev 0.3 (x.y of current CPLD—Complex Programmable Logic Device) 

Self-Test Ok = All power-on self-tests passed 
Fault = One or more power-on self-tests failed 
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View Diags 
 

 
The View Diags Sub-Menu displays up to 11 System Diagnostics, none of which are editable. The first two System 
Diagnostics are critical. If any of them indicate a Fault condition, the I3DL I3  will not enter or remain in Run mode, 
and the problem must be investigated and corrected. 

 

Logic Error Ok = All executed ladder instructions are legal for loaded firmware 
Fault = A ladder instruction not supported by firmware was found 

User Program Ok = Ladder program and I/O configuration loaded successfully 
Fault = Ladder program or I/O configuration not loaded, or load failed 

 
The last nine System Diagnostics are informational. If any of them indicate a Warning condition, the I3DL can still 
enter and remain in Run mode, but the problem should be investigated and corrected. 

 

User Graphics Ok = Application graphics objects loaded successfully 
Fault = Application graphics objects not loaded, or load failed 

W-Dog Trips 0 = Watchdog timer has not tripped since the last power-up 
x = Number of times watchdog timer has tripped 

Net Errors 0 = No CAN network bus-off errors have occurred 
x = Number of CAN network bus-off errors that have occurred 

Network State Ok = At least one other node was found on the CAN network 
Warning = No other nodes were found on the CAN network 

Network ID Ok = This node’s CAN Network ID is in the range 1 to 253 
Warning = This node’s CAN Network ID was out of range at power-up 

Dup Net ID Ok = This node’s Network ID is unique on the CAN network 
Warning = This node’s Network ID is duplicated in another node 

Clock Error Ok = Time and date have been set 
Warning = Time and date need to be set 

I/O System Ok = I/O configuration matches the installed I/O and COM modules 
Warning = I/O configuration needs updating to match installed modules 

Battery Ok = Backup battery operating properly 
Warning = Backup battery needs to be replaced 
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View Protocols 
See also: "Protocol Configuration " on page 98 

 

 
The View Protocols Sub-Menu displays three System Settings, none of which are editable. 

 
As mentioned in Downloadable Serial Communication Protocols section, both the MJ1 (Port 1) and MJ2 (Port 2) 
serial ports support downloadable protocols. To assign a downloadable protocol to an I3DL serial port, select the 
Protocol Config item in software’s Program menu and then setup a protocol for Port 1 or Port 2 (or both). 

 
In the View Protocols Sub-Menu, the currently downloaded protocol, if any, and its version number are displayed for 
both Port 1 and Port 2. 

 
Port 1 
Protocol Name (None Loaded) or name of the protocol assigned to MJ1 
Protocol Version Blank or version of the protocol assigned to MJ1 
Port 2 
Protocol Name (None Loaded) or name of the protocol assigned to MJ2 
Protocol Version Blank or version of the protocol assigned to MJ2 
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Set Keys, Serial Ports, Time/Date, Beeper & Screen 
Set Fkeys Mode 

 
The Set Fkeys Sub-Menu displays two System Settings, both of which are editable. 

 

Fkeys Momentary = %K1-4 bits go On & Off as F1-F10 are pressed & released 
Toggle = %K1-10 bits toggle each time F1-F4 are pressed 

SYS_Fn enable Yes = Reset and all clear system functions enabled 
No = Reset and all clear system functions disabled 
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Set Serial Ports 

See also: "Serial Communications" on page 1 

The Set Serial Ports Sub-Menu displays three System Settings, all of which are editable, and one optional item. 

Dflt Pgm Port MJ1-232 = MJ1 – RS232 port is the default programming port 

MJ2 RS485 Bias No = MJ2 RS485 bias resistors are not switched in 
Yes = MJ2 RS485 bias resistors are switched in 
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Set Time/Date 
 

 
The Set Time/Date Sub-Menu displays three System Settings. Time and Date are editable, and Day is automatically 
calculated from the Date setting. 

 
NOTE: Time and Date are split into three editable fields each. Use ← or → to select a field and then use ↑ or ↓ to edit 
the field. 

 
Time 16:09:49 = Current time (hours:minutes:seconds in 24-hour format) 
Date 10-Jun-1996 = Current date (day-month-year) 
Day Monday = Current day of week calculated from the Date setting 

 
NOTE: The i3DL must be power-cycled (or reset) before the changes take effect. 
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Set Beeper 
 

 
The Set Beeper Sub-Menu displays one System Setting, which is editable. 

 

Beeper Enable Yes (default) = Enables beeper 
No = Disables beeper (does NOT affect ladder access) 
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Set Screen 
 

The Set Screen Sub-Menu displays four System Settings, all of which are editable. 
 

 
Saver enable Yes = Enable screen saver 

No (default) = Disable screen saver 

Timeout (min) 5 - 1200 = Amount of time in minutes to expire with NO touch activity before activating screen 
saver (black screen) 

 
Popup Status 

Off (default) = Disable popup status 
Warning = Display popup status only if controller status changes to NOT Ok or NOT Run mode. 
On = Display popup status on any controller status change. 

Update Time 
(mS) 2 - 50 = Maximum amount of time to allow for graphics update per scan 
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Removable Media 
See also: "Removable Media" on page 1 

 
 

The Removable Media Sub-Menu displays the Removable Media Manager. After selecting Removable Media from 
the Main Menu, one of four Sub-Menu screens will appear: 

 

 

If a directory name is highlighted, pressing Enter will switch to that directory showing its files and sub-directories. In 
a sub-directory, highlighting .. (dot dot) and pressing Enter will move up one directory. 
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Calibrate Analog 
When first entering this option, the user is presenting with information about the I3DL model and current state of the 
IO points. Refer to "General I/O Configuration" on page 1 for more details. 

 

 
 
 
 

The I and Q sections indicate the ON and OFF status of the individual digital inputs and outputs respectively. The AI 
values show the raw analog inputs scaled from 0 to 32,000. The AQ items show the raw analog outputs scaled from 
0 to 32,000. 

 
The “Calibrate Analog” item is a sub-menu that, when selected, allows entering the field calibration for analog inputs 
and outputs. 

 
NOTE: The I3DL must be power-cycled (or reset) before the changes take effect. 
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Fail – Safe System 
 

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of 
"soft" failures. These "soft" failures include: 

n Battery power loss 
n Battery-Backed Register RAM or Application Flash corruption due to, for example, an excessive EMI, 

Electromagnetic Interference, event. 
 

Selecting “Fail-Safe System” menu will open the following menu screen: 
 

 
Selecting Backup/Restore Data displays the following screen in: 

 

 
 

Backup = Copies battery-backed RAM contents on to the onboard flash memory of the I3 . 
Restore = Copies the backed-up data from onboard flash to the battery-backed RAM. 
Clear Backup = The backup data will be erased from the onboard flash. 
Exit = Goes back to previous menu 
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Enable AutoRun 
 

“Enable AutoRun” displays the following options which can be selected: 
 

 
No = i3 will be in IDLE mode after AutoLoad or Automatic Restore. 
Yes = i3 will automatically be placed into RUN mode after AutoLoad or Automatic Restore. Enable AutoRun 
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Enable AutoLoad 
 

“Enable AutoLoad” displays the following options which can be selected: 
 

 
 
Enable 
AutoLoad 

No = Does not load AUTOLOAD.PGM automatically when application program is absent or 
corrupted. 
Yes = Loads AUTOLOAD.PGM file automatically from RM when application program is absent or 
corrupted. 
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Clone Unit 
 

 
‘Clone Unit’ feature allows the user to “clone” the I3  of the exact same model. This feature “clones” application 
program and unit settings stored in battery-backed RAM of an I3  into the RM. Refer to "Removable Media" on 
page 120 for details on using RM. It can then be used to clone a different I3  (same model). 

 
This feature can be used for: 

n Replacing an I3  by another unit of the same model. 
n Duplicating or “clone” units without a PC. 

 
 

Make Clone 
Selecting “Clone Unit” menu will open the following menu screen: 

 
Load Clone and Make Clone virtual buttons are below the screen. Free/Total: Displays number of Free and Total 
bytes in Removable Media. 

 
Selecting Make Clone brings up the screen below for the user: 
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After confirmation, the I3 will create two new files in the root directory of the Removable Media Drive as shown 
below: 

 
AUTOLOAD.PGM Application file 
CLONE.DAT File having all unit settings and register values from battery-backed RAM 
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Load Clone 
 

Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone” (one of the virtual buttons 
beneath the screen). 

 

NOTE: For security enabled files, Load Clone asks for password validation before loading the application. 
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RMI License Details 
 

The license details page displays the information about the RMI license. The information can also be viewed from i3 
configurator using the following %SR registers: 

 
%SR209.3 RMI server status 
%SR209.4 RMI user logged in status 

%SR209.9 to SR209.16 Number of Users 
%SR218 Number of Webpages 
%SR219 Number of Data Points 

%SR220-SR222 Expiry Date of RMI License 
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Touch Screen Calibration 
The touch screen is calibrated at the factory and rarely needs modification. However, if actual touch locations do not 
appear to correspond with responding objects on the display, field adjustment is available. Ensure SYS_fn Enable is 
set to YES in System Menu. To access the field adjustable touch screen calibration dialog, press and hold both the 
SYS and F1 key for longer than 2 seconds and a dialog similar to the figure below will appear. 

 

 
NOTE: Advanced options, accessed by holding the system key down, may be locked out from user access. If hold- 
ing the SYSTEM key does NOT respond, verify that the system menu’s Set Fkeys sub-menu’s parameter SYS_Fn 
is enabled. 

 
For the best results in screen calibration, use a stylus with a plastic tip. When the crosshair appears, touch the center 
of the crosshair as exactly as possible and release. A small “+” should appear and will move closer to the center of 
the crosshair. Once it has done so and disappeared again, repeat the process until “+” appears in the center of the 
crosshair. Then move on to the next step. 
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System Registers 
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System Register Tables 
Register Definitions 48 
%S Registers 49 
%SR Registers 50 
I/O Register Map for I3DL  57 
I3DL Resource Limits 57 
PWM Function Registers Map 58 
HSC Functions Registers Map 58 

There are two types of System Registers that may be used during programming. %S registers indicate the status of 
several system operations. %SR registers indicate the state of many system operations and can be used to control 
them in several cases. Some of the system registers have predefined I/O names, though they may still be changed 
if desired. 

Register Definitions 
When programming an I3DL , data is stored in memory that is segmented into different types. This memory in the 
controller is referred to as registers. Different groups of registers are defined as either bits or words (16 bits). Multiple 
registers can usually be used to handle larger storage requirements. For example, 16 single-bit registers can be used 
to store a word, or two 16-bit registers can be used to store a 32-bit value. 

Types of Registers 

%AI = Analog Input 
16-bit input registers used to gather analog input data such as
voltages,
temperatures, and speed settings coming from an attached device.

%AQ = Analog Output 
16-bit output registers used to send analog information such a
voltage,
levels or speed settings to an attached device.

%D = Display Bit 

These are digital flags used to control the displaying of screens on a 
unit. 
which can display a screen. If the bit is SET, the screen is 
displayed. 

%I = Digital Input Single-bit input registers. Typically, an external switch is connected to 
the registers. 

%K = Key Bit Single-bit flags used to give the programmer direct access 
to any front panel keys appearing on a unit. 

%M = Retentive Bit Retentive single-bit registers. 

%Q = Digital Output 
Single-bit output registers. Typically, these bits are connected to an 
actuator, 
indicator light or other physical outputs. 

%R = General Purpose Register Retentive 16-bit registers. 
%S = System Bit Single-bit bit coils predefined for system use. 
%SR = System Register 16-bit registers predefined for system use.
%T = Temporary Bit Non-retentive single-bit registers. 
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%S Registers 
%S registers indicate system status as follows: 

 

%S Registers 
S# Name Predefined I/O 

Name 
Notes 

%S1 First Scan FST_SCN On for 1 scan only each time the program is first run 
%S2 Network OK NET_OK If on, the Network is OK 
%S3 10ms pulse T_10MS Cycling pulse that is high for 5ms and low for 5ms 
%S4 100ms pulse T_100MS Cycling pulse that is high for 50ms and low for 50ms 
%S5 1 second pulse T_1SEC Cycling pulse that is high for 500ms and low for 

500ms 
%S6 I/O OK IO_OK If on, the I/O system is OK 
%S7 Always On ALW_ON This bit is always on 
%S8 Always OFF ALW_OFF This bit is always off 
%S9 Pause Scan PAUSING_SCN On for at least 1 scan prior to Pause 'n Load 
%S10 Resume Scan RESUMED_SCN On for 1 scan only after Pause 'n Load is done 
%S11 Forcing Present FORCE If on, I/O is presently being forced 
%S12 Forcing 

Enabled 
FORCE_EN If on, I/O forcing has been enabled 

%S13 Net I/O OK NET_IO_OK If on, Network I/O is OK 
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%SR Registers 
%SR registers are special word-length registers that display and/or control system operations in the controller. Not 
all controllers support all defined system registers. 

 
%SR Registers 

SR # Name and Description Default I/O 
Name 

Min - 
Max Val- 

ues 

Program 
(Read/Write) 

Display 
(Read/Write) 

%SR1 User Screen Number (0=none) USER_SCR 0 to 
1023 

Read/Write Read/Write 

%SR2 Alarm Screen Number ALRM_SCR 0 to 1-23 Read Only Read Only 
%SR3 System Screen Number 

1 = Main System Menu 
2= Set Network ID, Network Status, 
(%SR29) 
3= Set Network Baud (%SR30) 
4= Set Contrast (%SR32) 
5= View I3  Status 
6= View I3  Diagnostics 7= 
View I/O Slots 
8= Set Function Key Mode (%SR33) 
9= Set Serial Ports (%SR34) 
10= Set Time/Date (%SR44-%SR50) 
11= Set Beeper (%SR183) 
12= Set Screen (%SR185) 
13= Removable Media 
14= View Protocols 
15= IP Address IP Address (ETN I/O 
Board) 
16= Fail Safe System 
17= Backup / Restore Data 
18= Enable AutoRun 
19= Enable AutoLoad 
20= Clone Unit - 
21= Touch Calibration 
24= License Details 

SYS_SCR 0 to 24 Read/Write Read/Write 

%SR4 Self-Test Results SELF_TEST  Read Only Read Only 
%SR4.1 Self-Test Results - BIOS Error   Read Only Read Only 
%SR4.2 Self-Test Results - Engine Error   Read Only Read Only 
%SR4.3 Self-Test Results - Ladder Error   Read Only Read Only 
%SR4.4 Self-Test Results - RAM Error   Read Only Read Only 
%SR4.5 Self-Test Results - Duplicate ID Error   Read Only Read Only 
%SR4.6 Self-Test Results - Bad ID Error   Read Only Read Only 
%SR4.7 Self-Test Results - I/O Configuration 

Error 
  Read Only Read Only 

%SR4.8 Self-Test Results - Bad Network Error   Read Only Read Only 
%SR4.9 Self-Test Results - Bad Logic Error   Read Only Read Only 
%SR4.10 Self-Test Results - Bad Clock Error   Read Only Read Only 
%SR4.11 Self-Test Results - DeviceNet Error   Read Only Read Only 
%SR4.12 - 16 Reserved     

%SR5 Reserved     

%SR6 Average Scan Rate ms ( / 10)   Read Only Read Only 
%SR7 Minimum Scan Rate ms ( / 10)   Read Only Read Only 
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%SR Registers 

%SR8 Maximum Scan Rate ms ( / 10)   Read Only Read Only 
%SR9 Current Touch Pressure TCH_ 

PRESSURE 
0 to 
3000 

Read Only Read Only 

%SR10 Threshold Touch Pressure TCH_ 
PRESSURE_ 

TSH 

0 to 
3000 

Read/Write Read/Write 

%SR11-12 Ladder Size (32-Bit DINT)   Read Only Read Only 
%SR13-14 User Text Screen Size (32-Bit DINT)   Read Only Read Only 
%SR15-16 System Text Screen Size (32-Bit DINT)   Read Only Read Only 
%SR17-18 I/O Configuration Table Size (32-Bit 

DINT) 
  Read Only Read Only 

%SR19-20 Network Config Table Size (32-Bit 
DINT) 

  Read Only Read Only 

%SR21-22 Security Data Table Size (32-Bit DINT)   Read Only Read Only 
%SR23 Ladder Code CRC   Read Only Read Only 
%SR24 User Text CRC   Read Only Read Only 
%SR25 System Text CRC   Read Only Read Only 
%SR26 I/O Configuration Table CRC   Read Only Read Only 
%SR27 Network Configuration Table CRC   Read Only Read Only 
%SR28 Security Data Table CRC   Read Only Read Only 

      

%SR29 Network ID  
NET_ID 

 Read Only Read/Write 
iCAN Mode 1 to 

253 
DeviceNet Mode 0 to 63 
CANopen Mode 1 to 

127 
%SR30 Network Baud Rate 

0=125KB 
1= 250kB 
2= 5000KB 
3= 1MB 
4=50K 

 0 to 4 Read Only Read/Write 

%SR31 Network Required 
0= Network not required 
1= Network required. 
2= Network optimized. 
3= Network required and optimized 

 0 to 3 Read Only Read Only 

%SR32 LCD Display Contrast setting  0 to 255 Read Only Read/Write 
%SR33 Function Key Toggle Mode 

0= Momentary 
1= Toggle 

 0 to 1 Read/Write Read/Write 

      

%SR34 RS232 Serial Protocol Mode 
0= Firmware Update (RISM) 
1= iCAN 
2= Generic (Ladder- Controlled) 
3= Modbus RTU 
4= Modbus ASCII 

  Read Only Read Only 

%SR35-36 Unique Serial Number / Hexadecimal 
l LAN1 MAC ID 

  Read Only Read Only 
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%SR Registers 

%SR37 Model Number   Read Only Read Only 
%SR38 Engine Version ( /100)   Read Only Read Only 
%SR39 BIOS Rev Number ( / 100)   Read Only Read Only 
%SR40 FPGA Image Rev Number ( / 10)   Read Only Read Only 
%SR41 Vertical Pixel Count   Read Only Read Only 
%SR42 Horizontal Pixel Count   Read Only Read Only 
%SR43 Keypad Type   Read Only Read Only 
%SR44 Real-Time-Clock Second RTC_SEC 0 to 59 Read Only Read Only 
%SR45 Real-Time-Clock Minute RTC_MIN 0 to 59 Read Only Read Only 
%SR46 Real-Time-Clock Hour RTC_HOUR 0 to 23 Read Only Read Only 
%SR47 Real-Time-Clock Date RTC_DATE 1 to 31 Read Only Read Only 
%SR48 Real-Time-Clock Month RTC_MONTH 1 to 12 Read Only Read Only 
%SR49 Real-Time-Clock Year RTC_YEAR 1996 to 

2095 
Read Only Read Only 

%SR50 Real-Time-Clock Day (1=Sunday) RTC_DAY 1 to 7 Read Only Read Only 
%SR51 Network Error Count   Read Only Read Only 
%SR52 Watchdog-Tripped Error Count   Read Only Read Only 
%SR53-54 Reserved     

%SR55.13 Self-Test: Battery Low or Missing   Read Only Read Only 
%SR56 Key Currently Pressed 

No key = 0 (No key pressed since 
power-up) F1 = 1 
F2= 2 
F3= 3 
F4 = 4 
F5= 5 
F6= 6 
F7=7 
F8= 8 
F9= 9 
F10 = 10 
F11= 11 
F12 = 12 
Enter = 13 
+/ - = 14 
. (dot) = 15 
0 = 16 
1 = 17 
2 = 18 
3 = 19 
4 = 20 
5 = 21 
6 = 22 
7= 23 
8 = 24 
9 = 25 
System = 26 
Escape = 27 
Left = 28 
Right = 29 
Up = 30 
Down = 31 
Shift = 32 
Soft Key 1 = 34 
Soft Key 2 = 35 
Soft Key 3 = 36 

LAST_KEY 0 to 255 Read Only Read Only 
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%SR Registers 

 Soft Key 4 = 37 
Soft Key 5 = 38 
Soft Key 6 = 39 
Soft Key 7 = 40 
Soft Key 8 = 41 
Release = 255 (Keys pressed since 
power- 
up but not currently) 

    

%SR57 LCD Backlight Dimmer Register 
0-100 = 0% to 100% On 
100-255 = 100% On 

 0 to 255 Read Only Read Only 

%SR57.16 Temporarily disable Screen Saver   Read/Write Read/Write 

%SR58 User LEDs USER_LEDS  Read/Write Read/Write 
%SR59 Engine Build Number 

(Only last three numbers displayed) 
  Read Only Read Only 

%SR60 Build Option 
Build Test = 0 
Build Beta = 1 
Build Product = 2 

 0 to 2 Read Only Read Only 

%SR61 Number of ICAN Network IDs NUM_IDS  Read Only Read Only 
%SR62-100 Reserved     
%SR101.3 RMI License Details – RMI server status 

I3AX & I3BX only 
  Read Only Read Only 

%SR101.4 RMI License Details – RMI user 
logged in status. 
I3AL, I3CL, I3EL & I3DL 

  Read Only Read Only 

%SR101.8 - 101.16 RMI License Details – Number of 
users 
I3AL, I3CL, I3EL & I3DL 

  Read Only Read Only 

%SR102 - 107 Reserved     

%SR108 RMI License Details – Number of 
webpages 
I3AL, I3CL, I3EL & I3DL 

  Read Only Read Only 

%SR109 RMI License Details – Number of 
datapoints 
I3AL, I3CL, I3EL & I3DL 

  Read Only Read Only 

%SR110-112 RMI License Details – Expiry date of 
RMI license 
I3AX & I3BX only 

  Read Only Read Only 

%SR113-130 Reserved     
%SR131-135 I3  Model: ASCII, 10 characters   Read Only Read Only 
%SR136 Communication Download Timeout   Read Only Read Only 
%SR137 Communication Idle Timeout   Read Only Read Only 
%SR138-148 Reserved     
%SR149-150 Free-running 10kHz count: 1 count = 

0.1ms 
(32-Bit DINT) 

  Read Only Read Only 

%SR151 Reserved     
%SR152 RS-485 Termination   Read/Write Read/Write 
%SR152.1 MJ2 Termination Enable   Read/Write Read/Write 
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%SR Registers 

      

%SR152.2 RS485 Termination Enable 
I3CL, i3EL & I3DL 

  Read/Write Read/Write 

%SR152.3 Reserved     

%SR152.4 CAN Termination Enable 
I3CL, i3EL & I3DL 

  Read/Write Read/Write 

%SR153 - 163 Reserved     
%SR164 Fail-Safe / clone     
%SR164.1 RS485 Port Biasing #1 (MJ1 or MJ2)   Read/Write Read/Write 
%SR164.2 RS485 Port Biasing #2 (MJ2 or MJ3)   Read/Write Read/Write 
%SR164.3 Indicates Automatic Restore Operation 

has been performed 
AUTO_ 

RESTRD 
 Read Only Read Only 

%SR164.4 Indicates Backup of Registers has been 
taken 

BCKUP_TAKN  Read Only Read Only 

%SR164.5 Enable AUTORUN – Sets “Enable 
AutoRun” to “Yes” or “No” 

EN_AUTO_LD  Read/Write Read/Write 

%SR164.6 Enable AUTOLOAD – Sets “Enable 
AutoLoad” to “Yes” or “Not” 

EN_AUTO_LD  Read/Write Read/Write 

%SR164.7 Start Backup trigger bit – 
Setting TRUE starts backup of all 
register data 

STRT_BCKUP  Read/Write Read/Write 

%SR164.8 Clear Backup trigger bit – Setting TRUE 
clears backup of all register data (if a 
backup was done previously) 

CLR_BACKUP  Read/Write Read/Write 

%SR164.9 MAKE_CLONE trigger bit = 
Setting TRUE does a Load Clone 
(if a media card is present) 

MAKE_ 
CLONE 

 Read/Write Read/Write 

%SR164.10 LOAD_CLONE trigger bit – 
Setting TRUE does a LOAD CLONE 
(if a media card is present that contains 
clone files) 

LOAD_ 
CLONE 

 Read/Write Read/Write 

%SR164.11 Make Clone Fail 
(This bit goes high when Make/Create 
Clone fails) 

MK_CLN_FL  Read/Write Read/Write 

%SR164.12 Load Clone Fail 
(This big goes high when Load Clone 
fails) 

LD_CLN_FL  Read/Write Read/Write 

      

%SR164.14 Reserved   Read/Write Read/Write 
%SR164.15 Reserved   Read/Write Read/Write 
%SR165-166 Reserved     
%SR167 Screen Update Time, Default= 10  2 to 50 Read/Write Read/Write 
%SR168-170 Reserved     
%SR171 X-Coordinate Touched   Read Only Read Only 
%SR172 Y-Coordinate Touched   Read Only Read Only 
%SR173 System-Function Disable  0 to 1 Read/Write Read/Write 
%SR174 Removable Media Protect   Read/Write Read/Write 
%SR174.1 Request Media Card be Removed   Read/Write Read/Write 
%SR174.2 Indicates safe to remove Media Card   Read/Write Read/Write 
%SR175 Removable Media - Status   Read Only Read Only 
%SR176-177 Removable Media Free Space (32-Bit 

DINT) 
  Read Only Read Only 
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%SR Registers 

%SR178-179 Removable Media Total Space (32-Bit 
DINT) 

  Read Only Read Only 

%SR180 Reserved     

%SR181 Bits 1-16 indicate Unacknowledged in 
Alarm Groups 1-16 

ALM_UNACK  Read Only Read Only 

%SR182 Bits 1-16 indicate Active in Alarm 
Groups 1-16 

ALM_ACT  Read Only Read Only 

%SR183 Beep on Keypress Enable 
0= Disabled 
1= Enabled 

SYS_BEEP 0 to 1 Read/Write Read/Write 

%SR184 Internal Beeper 
0=OFF 
1=ON 

USER_BEEP 0 to 1 Read/Write Read/Write 

%SR185 Screen Saver Enabled 
0= Disabled 
1= Enabled 
NOTE: See %SR57.16 

 0 to 1 Read Only Read Only 

%SR186 Screen Saver Time in minutes (delay)  5 to 
1200 

Read Only Read Only 

%SR187 Network Usage (Avg) NET_USE 0 to 
1000 

Read Only Read Only 

%SR188 Network Usage (Min)  0 to 
1000 

Read Only Read Only 

%SR189 Maximum Net Usage of all units on the 
CAN network 

 0 to 
1000 

Read Only Read Only 

%SR190 Network TX Usage % ( / 10) (Avg) NT_TX_AVG 0 to 
1000 

Read Only Read Only 

%SR191 Network TX Usage % ( / 10) (Min)  0 to 
1000 

Read Only Read Only 

%SR192 Network TX Usage % ( / 10) (Max)  0 to 
1000 

Read Only Read Only 

EXTENDED SYSTEM REGISTERS 
%SR193 Online Change ONLINE_CHG    
%SR193.1 TRUE if 2 programs in target FLASH   Read Only Read Only 
%SR193.2 TRUE to switch programs, FALSE when 

complete 
  Read Only Read Only 

%SR193.3 TRUE if executing program is tem- 
porary test 

  Read Only Read Only 

%SR193.4 TRUE during last scan of switched-from 
program 

  Read Only Read Only 

%SR193.5 TRUE during first scan of switched-to 
program 

  Read Only Read Only 

%SR193.6 TRUE to revert to FLASH and delete all 
RAM; FALSE when complete 

  Read Only Read Only 

%SR193.9 TRUE if error in temporary program   Read Only Read Only 
%SR194 Reserved     

%SR195 Reserved     
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%SR Registers 
%SR196 Reserved 
%SR197 Reserved 
%SR198 Reserved 
%SR199 Reserved 
%SR200 InitRD Version ( /100) Read Only Read Only 
%SR201 - 205 Linux Kernel version: ASCII, 10 char- 

acters 
Read Only Read Only 

%SR206-208 Reserved 
%SR209.3 I3RMI Server Status. Bit 3 is ON if 

server running. 
Read Only Read Only 

%SR209.4 I3RMI User Logged in Status. 
Bit 4 is ON if 1 or more users logged in. 

Read Only Read Only 

%SR209.8 - 209.14 Number of Users. 
Shows in upper byte in decimal format. 

Read Only Read Only 

%SR210 Time Zone: set in minutes + / -UTC (Ex: 
EST is -4 hours = -240 minutes) 

Read/Write Read/Write 

%SR211 Daylight Saving: YES = 1 
Daylight Saving: NO = 0 
(If daylight saving is enabled, 
one hour will be added to the local time). 

Read/Write Read/Write 

%SR212 UTC - Seconds Read Only Read Only 
%SR213 UTC - Minutes Read Only Read Only 
%SR214 UTC - Hours Read Only Read Only 
%SR215 UTC - Date Read Only Read Only 
%SR216 UTC - Month Read Only Read Only 
%SR217 UTC - Year Read Only Read Only 
%SR218 Reserved 
%SR219 Reserved 
%SR220-222 Reserved 
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I/O Register Map for I3DL I3 
NOTE: These registers can be used as general-purpose registers 

Fixed 
Address 

Digital/Analog 
I/O Function 

I3DL Models 
Relay Transistor 

%I 
Digital Inputs 1-12 1-12

Reserved 13-32 13-32

%Q 

Digital Outputs 1-2 1-12
Relay Outputs 3-8 -- 

Reserved 9-16 13-16

%AI 
Analog Inputs 1-4 1-4

Reserved 5-12 5-12

%AQ 
Analog Outputs 1-2 1-2

Reserved 3-14 3-14

I3DL Resource Limits 
Resource Value 

%I 1024 
%Q 1024 
%AI 256 
%AQ 256 
%M 1024 
%T 1024 
%R 5,000 
%D 250 
%K 20 
%S 13 

ICAN 125kBd, 250kBd, 500kBd, or 1MBd 
IDs Per ICAN Network 64 w/o repeat (253 w/ 3 repeaters) 

Serial Ports 1 RS232, 1 RS485 Ports (Single Connector) 
Keypad Slide Keys (Touch) 
Display 10.4” Color TFT 

Screen Memory 256kB 
User Screens 250 

No. of Objects per Page 30 
Ladder Code 256kB 

Ethernet iCAN, Ping, Modbus TCP Master (Downloadable protocol) & Slave, Ethernet 
IP, FTP, or EGD (EGD does not support Multicast) 
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PWM Function Registers Map 
Register PWM 
%AQ3 

-- 
%AQ4 
%AQ5 

-- 
%AQ6 
%AQ7 

PWM1 Duty Cycle (32-bit) %AQ8 
%AQ9 

PWM1 Frequency (32-bit) %AQ10 
%AQ11 

PWM2 Duty Cycle (32-bit) %AQ12 
%AQ13 

PWM2 Frequency (32-bit) %AQ14 

HSC Functions Registers Map 
Register Frequency Totalize Pulse Quad 
%AI5-6 HSC1 (function) Accumulator Quad 1 Acc 
%AI7-8 HSC2 (function) Accumulator 

%AI9-10 HSC3 (function) Accumulator Quad 2 Acc 
%AI11-12 HSC4 (function) Accumulator 
%AQ1-2 HSC1 Preset 
%AQ3-4 HSC2 Preset 
%Q17 Clear HSC1 Clear Quad 1 
%Q18 Clear HSC2 Set Quad 1 
%Q19 Clear HSC3 Clear Quad 2 
%Q20 Clear HSC4 Set Quad 2 
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Built-in Digital and Analog I/O Overview 
The I3DL is a compact unit that contains high density and very versatile I/O. Using the I/O properly requires wiring to 
the proper terminals and configuring i3 configurator properly. This section will offer some tips and suggestions to 
configure the I/O properly.  

Model and I/O Overview 

I3DL 
Models 

Solid State 
Digital Outputs Relay Outputs Digital Inputs Analog Inputs Analog Outputs 

10D14 ü ü ü ü 

10D12 ü ü ü ü ü 

. 
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Digital / HSC Input Configuration 
NOTE: The digital inputs on the I3DL are designed for low voltage DC inputs. 

The inputs are designed to support both positive and negative input modes. The mode is set by software setting in 
i3 configurator and a configuration parameter also in i3 configurator. All the inputs on the unit must be configured 
to the same mode. 

In positive logic mode a positive voltage applied to the input will turn the input. The internal design of this mode is 
basically a resistor from the input to I/O ground. This mode is sometimes called sourcing. 

In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input on. The internal design 
of this mode is basically a resistor from the input to the positive I/O voltage (usually 12 or 24V). This mode is some- 
times called sinking. 

Some of the digital inputs may support high-speed input functional such as counting or frequency measurement. 

 Digital Input J2 Wiring 
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Digital Input Configuration 

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod- 
ule Setup > Digital In/HSC 

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are 
selectted. Then select the Local I/O tab. 

After selecting Local I/O, select the Config button next to the I/O connector. 

The Module Configuration screen will appear, select the Module Setup tab. See below. 
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The Module Setup allows a user to configure four types of I/O. NOTE: Not all controllers offer all four types. 
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Select Digital In/HSC to open the Digital / HSC Input configuration dialog for a specific controller. 

The Active mode group box allows the user to select if inputs are active high (Positive logic) or active low (Negative 
logic). It is important that this setting matches the jumper settings on the hardware. 

The High-Speed Counters group box contains all the windows that are used to configure the four available high- 
speed counters on the i3 . To configure a counter, the user needs to set the type, mode, and counts per rev. 

The type drop down includes the following options: 
l Disabled
l Frequency
l Totalize
l Pulse
l Quadrature
l Marker (Only available in counter #3 if counter #1 is set to quadrature.)
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The mode drop-down items are set according to the type of selection. The Counts Per Rev. window is 
enabled/dis- abled according to the type of selection as well. 
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Digital / PWM Output Configuration 
Solid-State Digital Outputs 
I3DL – 10D14: Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and 
other low voltage and low current devices. 

NOTE: The digital outputs used on the i3DL are “sourcing” outputs. This means the output applies a positive voltage 
to the output pin when turned ON. When turned off, the output applies approximately zero volts with respect to the I/O 
ground. 

The digital outputs used in the I3DL have electronic short circuit protection and current limiting. While these electronic 
protections work in most applications, some applications may require external fusing on these outputs. 

The digital outputs in the i3DL are typically controlled via %Q bits in the register mapping. Some of the outputs are designed 
for high-speed applications and can be used for PWM or frequency output applications. Refer to the I3DL datasheet and 
the High-Speed I/O chapter for additional information. 

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they 
were in before the controller stopped or they can go to a predetermined state. By default, digital outputs turn off. For 
more information on Stop State, refer to "i3 configurator Configuration" on page 1. 

The digital outputs feature an output fault bit. %I32 will turn on if any of the outputs experience a short circuit, over- 
current or the output driver overheats. 

Digital Output Wiring 
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Relay Outputs 
Relay outputs are designed to switch loads that typically have high voltage or current requirements or require the 
isolation that relays provide. Relay outputs are not available on all controllers, see the datasheet. NOTE: The design 
of the I3  does not require external coil power for the relays to function. The relays will activate anytime the I3  is 
powered. There are several factors that should be considered when using relays: 

l Relay Life – Relays are mechanical devices that have a long but limited life. Typically, switching more cur- 
rent limits the life of relays. Please check the data sheets at the end of this manual for expected relay life.

l Current / Temperature De-Rating – Products containing relays often have total current limits based on the
ambient temperature of the application. Please see the product data sheet for current / temperature de-rating
information for relays.

l Fusing – External fusing is generally required to protect the relays, devices and wiring from shorts or over- 
loads.

WARNING: To protect the module and associated wiring from load faults, use external (5A) fuse(s) as shown. 
Fuses of lower current or fusing for the entire system need to be in place to assure the maximum current rating of 
the unit is not exceeded. 

WARNING: Connecting high voltage to any I/O pin can cause high voltage to appear at other I/O pins. 

Protection for Inductive Loads – Inductive loads can cause reverse currents when they turn off that can shorten 
the life of relay contacts. Some protective measures must be determined by an engineer. Below are some 
recommendations that will work for many applications. If there are additional questions on protection from inductive 
load, consult IMO Technical Support. 

n DC Loads – General purpose diode (IN4004) in reverse bias across the load.
n AC Load – MOV (Harris V140xxx for 120V, V275xx for 220V)

Output State on Controller Stop – When the controller is stopped the operation of each output is configurable. 
The outputs can hold the state they were in before the controller stopped or they can go to a predetermined state. 
By default, relay outputs turn off. For more information on the stop state, refer to "i3 configurator Configuration" on 
page 1. 
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10D12: Sinking and Sourcing Outputs 
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Digital Output Configuration 
Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod- 
ule Setup > Digital Out/PWM 

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are 
selected. Then select the Local I/O tab. 

After selecting Local I/O, select the Config button next to the I/O connector. 
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The Module Setup allows a user to configure four types of I/O. NOTE: Not all controllers offer all four types. 

Select Digital Out/PWM to open the Digital / PWM Output Configuration 



General I/O Configuration 

 

72  

 
 

 

The Q1 and Q2 group boxes allow the user to specify the operation of the multifunction outputs. 
 

The PWM State on Controller Stop group box contains items that allow the user to specify how the PWM outputs behave 
when the controller is stopped. These items can either hold their value or default to some value when the controller is 
stopped. 

 
NOTE: The PWM outputs are set to the OFF state at power-up and during program download and remain in that 
state until the unit is placed in RUN. 

 
The Output State on Controller Stop group box contains items to allow the user to specify how the remaining 
digital outputs behave when the controller is stopped. These items can either hold their value or default to some 
value when the controller is stopped. 
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Analog Input Configuration 
The analog inputs on the i3  allow voltage or current measurement from a variety of devices. The voltage or cur- rent 
mode is set though jumpers on the unit and settings in i3 configurator. Each channel can be separately configured 
for voltage or current mode. 

The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in some 
installations. The downside to digital filtering is the inputs will respond more slowly to sudden changes in the actual 
input. 

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod- 
ule Setup > Analog In 

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are 
selected. Then select the Local I/O tab. 

After selecting Local I/O, select the Config button next to the I/O connector. 
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The Module Configuration screen will appear, select the Module Setup tab. See below. 

 

 
The Module Setup allows a user to configure four types of I/O. NOTE: Not all controllers offer all four types 
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Select Analog In to open the Analog Input Configuration dialogue: 

The Channel x drop down windows allow the user to specify the mode for each analog input to operate. The Channel 
x drop down windows are enabled/disabled according to which model is being configured. All of the models have 
the following modes available: 

l 0..10V 
l 0..20mA 
l 4..20mA 

 
NOTE: Each unused channel should be set to “Disable”. 
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The Filter Constant provides digital filtering to all channels. Valid filter values are 0-7 
 

Config Register: 
 

NOTE: If a Conf Register is configured, it takes immediate precedence over other configurations for the I/O, thus 
requiring valid values in the registers. These values can be changed during runtime so care needs to be taken to not 
mistakenly overwrite these values and program logic. 

 
Analog Input uses five consecutive 16-Bit registers for configuration and each register has the following description: 

 
%Rxx channel-1 Input Type selection 
%Rxx+1 channel-2 Input Type selection 
%Rxx+2 channel-3 Input Type selection 
%Rxx+3 channel-4 Input Type selection 
%Rxx+4 Filter Constant 

 
 

For example, if user entered %R1 in Config Register then: 
%R1 channel-1 Input Type selection 
%R2 channel-2 Input Type selection 
%R3 channel-3 Input Type selection 
%R4 channel-4 Input Type selection 
%R5 Filter Constant for all Input channels 

 
 

Analog Input type can be selected by entering appropriate Values in configured % R. 
Configuration Value to be entered 
Disable 10 
0 to 20mA 1 
4 to 20mA 2 
RTD 16 

 
In the above example if user entered %R1=2, then channel-1 Input Type will be 4 to 20mA. 
Filter constant is common for all Analog Input channels, Analog signals are filtered based on the constant value 
given in the %Rxx+4 register. The filter constant value should be in the range of 0 to 7 anything beyond this range 
will  be considered as constant value = 0. 
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Scaling Analog Inputs & Examples 
 

To access the Advanced Math Scaling function, select Home > View > Project Toolbox. This will open a side bar, 
and then select Advanced Math > Scale. 

 
Example 1 
The i3 configurator  Scale function, found in the Advanced Math functions, allows for very easy conversion of the raw 
input value into a meaningful reading. For example, a pressure transducer may be specified as a 4-20mA signal to 
signify a 0-2000 psi pressure reading. With the analog channel set to the 4~20mA range, the raw analog input value, 
which is in INT format ranges from 0 to 4mA to 32000 for 20mA. Use the Scale function to obtain an Integer pressure 
reading using the 0-32000 raw input range and the sensor’s 0-2000psi output range. 

 

Example 2: 
If readings with fractions are required, the raw Integer input value must first be translated in REAL, or Floating-Point 
Format, see note below. . The i3 configurator INT-to-REAL Conversion function may be used to convert the raw 
input value from INT to REAL format in an intermediate memory location. The SCALE function, specified as REAL 
type, may be used to scale the converted raw value into a reading that supports digits beyond the decimal place, 
i.e.475.25psi. 
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Analog Output Configuration 
NOTE: Refer to the I3DL datasheet and "High Speed I/O" on page 1 for more information. 

The analog outputs on I3DL devices provide high resolution current outputs. 

NOTE: Each channel can be separately configured for current mode. 
 

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they 
were in before the controller stopped or they can go to a predetermined value. By default, analog outputs are set to 
a value of zero (0).  

 
Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod- 
ule Setup > Analog Out 

 
Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are 
selected. Then select the Local I/O tab. After selecting Local I/O, select the Config button next to the I/O connector 

 
 

. 
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The Module Configuration screen will appear, select the Module Setup tab. See below. 
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Select Analog Out to open the following dialogue: 

 

 
The Output value on Stop group box contains items that allow the user to specify how the analog output channels 
behave when the controller is stopped. The outputs can either hold their value or default to a value when the con- 
troller is stopped. 

 
The Output Mode group box allows the user to select the operating modes for each of the analog outputs. The 
available mode is 4~20mA. 
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Config Reg - 
 

NOTE: If a Conf Register is configured, it takes immediate precedence over other configurations for the I/O, thus 
requiring valid values in the registers. These values can be changed during runtime so care needs to be taken to not 
mistakenly overwrite these values and program logic. 

 
Analog Output uses six consecutive 16-Bit registers for configuration and each register has the following description: 

%Rxx channel-1 Output Type selection 
%Rxx+1 channel-2 Output Type selection 
%Rxx+2 channel-1 Hold Last or Goto value selection 
%Rxx+3 channel-2 Hold Last or Goto value selection 
%Rxx+4 Channel-1 Goto value 
%Rxx+5 Channel-2 Goto value 

 
 

For example, if user entered %R10 in Config Register then: 
%R10 channel-1 Output Type selection 
%R11 channel-2 Output Type selection 
%R12 channel-1 Hold Last or Goto value selection 
%R13 channel-2 Hold Last or Goto value selection 
%R14 Channel-1 Goto value 
%R15 Channel-2 Goto value 

 
 

Analog Output type can be selected by entering appropriate Values in configured %R. 
 

Configuration Value to be entered 
Disable 10 

4 to 20mA 2 
 
 

In the above example, if user entered %R10=2, then Analog Output -1 type will be 4 to 20mA. 
Analog Output Hold last state or Goto value can be selected by entering appropriate values in configured %R. 

Configuration Value to be entered 
%Rxx+2 0 –Hold Last value of Analog output 

 1—Go to value in %Rxx+4 to Analog output -1 
%Rxx+3 0 –Hold Last value of Analog output 

 1—Go to value in %Rxx+5 to Analog output -2 
 

In the above example, if user entered %R12=0, then Analog Output channel-1 will hold the last value when con- 
troller is in Idle mode. 

 
In the above example, if user entered %R12=1 and %R14=12000, then Analog output channel-1 will Go to value 
12000 when controller is in Idle mode. 
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I/O Status and Calibration 
I/O Status 
The I and Q sections indicate the ON and OFF status of the individual digital inputs and outputs respectively. The AI 
values show the raw analog inputs scaled from 0 to 32,000. The AQ items show the raw analog outputs scaled from 
0 to 32,000. 

 
The X System Menu contains an “I/O Status and Calibration” selection. 
When first entering this option, the user is presented with information about the I3DL model and current state of the 
I/O points. 
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I/O Calibration 
 

This controller has a field calibration option in the System Menu. The calibration option can be used to achieve better 
accuracy than factory specifications and to compensate for calibration offsets that could occur with additional 
connectors and environmental conditions. Calibration is stored in non-volatile memory and is retained even if the 
backup battery fails or is removed. 

 
NOTE: Calibration of analog can only be performed when the controller is in idle mode. 

 
Analog output values will change so precautions show be taken such that changes in these outputs will not affect 
the system or the safety of those around the equipment. The calibration process applies changes to the analog 
inputs, so care must be taken that the calibration process will not adversely affect the operation of the attached 
equipment. 

 
Calibration should be performed by trained personnel with equipment that is designed for precise analog calibration. 
Ideally this equipment is also calibrated to a traceable standard. 

 
The “Calibrate Analog” item is a sub-menu that, when selected, allows entering the field calibration for analog inputs and 
outputs. 

 

 
The “Calibrate:” options allow selecting the individual input and output channels. Start by pressing select and using 
the up and down arrows to select the appropriate channel to calibrate. Next, the mode for the analog (if applicable) is 
selected using the “Mode:” option. 

 
n The “Save” button is used to save the calibration. 
n The “Accept” button is used to accept calibration values in the process. 
n The “Default” button is used to restore calibration to factory defaults. 
n The “Close” button is used to exit the calibration screen. 
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To calibrate 0-20mA, 4-20mA, or RTD PT100 Analog Inputs 
 

NOTE: During Calibration process, the application may be placed in Idle. 
 

1. Select the channel and mode as described above. 
2. Connect the analog channel to be calibrated to the calibration equipment. 
3. Apply the lower current or RTD value as directed by the screen to the selected analog input channel. 
4. Once the value on the screen is stable press the Accept button. 
5. Apply the higher current or RTD value. 
6. Move on to additional channels and repeat the above five steps. 
7. Make sure to press Save when all channels are calibrated. 

 
 

To calibrate 4-20mA Analog Outputs 
 

NOTE: During Calibration process, the application may be placed in Idle. 
 

1. Select the channel and mode as described above. 
2. Connect the analog output to be calibrated to a calibrator or precision meter. 
3. The controller will set the output to a lower analog output value. 
4. Read the value from the calibrator and enter it into the “Output Current:” item on the menu. 
5. Press Accept. 
6. The controller will set the output to a higher analog output value. 
7. Read the value from the calibrator and enter it into the “Output Current:” item on the menu. 
8. Press Accept. 
9. Move on to additional channels and repeat the above eight steps. 

10. Make sure to press Save when all channels are calibrated. 
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Serial Communications 
 

Port Descriptions 85 
Wiring—MJ1/MJ2 Serial Ports 85 
RS-485 Termination and Biasing 86  
Programming via Serial Port 86 
Ladder-Controlled Serial Communication 87 
Configuration via Mini-B USB 87 

 
 

All Controller models provide two serial ports, which are implemented with a single 8-position modular jack that is 
labeled MJ1/2. The MJ1 serial port is RS-232 while the MJ2 port is RS-485. MJ1 defaults to i3  programming by 
connecting it to the COM port of a PC running i3 configurator. In addition, both MJ1 and MJ2 can be used for 
application-specific communication, using a variety of standard data exchange protocols. 

 
 

Port Descriptions 
n The MJ1 serial port contains an RS-232 interface with RTS/CTS handshaking. 
n The MJ2 serial port contains half-duplex RS-485 interface with no handshaking. The MJ2 RS-485 interface 

provides switchable termination and bias resistors internally. 
 
 

Wiring—MJ1/MJ2 Serial Ports 
 
 

n MJ1: RS-232 w/Full Handshaking 
n MJ2: RS-485 Half-Duplex 

 
 

Pin MJ1 Pins MJ2 Pins 
 Signal Direction Signal Direction 

8 TXD OUT -- -- 
7 RXD IN -- -- 
6 0V Common 0V Common 
5 +5VDC @ 60mA OUT +5VDC @ 60mA OUT 
4 RTS OUT -- -- 
3 CTS IN -- -- 
2 -- -- RX- / TX- IN / OUT 
1 -- -- RX+ / TX+ IN / OUT 
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RS-485 Termination and Biasing 
Termination - Proper RS-485 termination minimizes reflections and improves reliability. 

 
The MJ2 serial port allows an internal termination resistor to be placed across pins 1 and 2 by software control. Only 
the two devices physically located at the endpoints of the RS485 network should be terminated. 

 
This termination is only in place when the Controller is powered on. This would typically only be an issue if the 
Controller is being used as a slave on the RS485 network. In that case, the electronic should not be used, but a 
physical external termination resistor should be used instead. 

 
Biasing - RS485 biasing passively asserts a line-idle state when no device is actively transmitting, which is useful 
for multi-drop RS485 networking. The MJ2 serial port allows internal bias resistor to be activated by software 
control, pulling pin 1 up to 3.3V and pulling pin 2 down to ground. 

 
NOTE: If biasing is used, it should be enabled in only one of the devices attached to the RS485 network. 

 
The “Set Serial Ports” option in the I3  System Menu can be used for termination and biasing. Also, an application 
graphics screen that writes to %SR can do the same thing. 

 
Biasing Details: 
 

n %SR152.3 enables RS485 Port Termination 
n %SR164.1 enables RS485 Port Biasing 

 
 
 

Programming via Serial Port 
MJ1 is the serial port available for programming. The connection is RS-232 and is compatible with the programming 
cable kit-i3PC45. Unlike some other I3  models, the MJ2 port cannot be configured as a programming port. The Mini-
B USB port is also available for programming. 

 
The “Set Serial Ports” option in the I3  System Menu contains an entry for Default Programming Port (Dflt Pgm 
Port). However, the entry is fixed at MJ1-232. No i3 configuration is required to use either the MJ1 serial port or 
Mini-B USB port for programming. NOTE: Only one i3 configurator software connection is allowed at a time. 
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Ladder-Controlled Serial Communication 
Using Serial Communication function blocks, both MJ1 and MJ2 support Generic, Modbus Master and Modbus 
Slave Protocols. In addition, external modems can be connected and accessed using Init, Dial and Answer Modem 
function blocks. 

 
 

Configuration via Mini-B USB 
NOTE: The unit must be connected via the mini-USB port to the PC or laptop. 

 
It is possible to load the program and monitor data via the Mini-B USB. To load via Mini-B USB, configure the com- 
munications port in i3 configurator as follows: 
Select Tools from the Toolbar > Application Settings > Communications > USB button. 

 
It is possible to download or upload and use the data monitoring functions once connected. 

 
NOTE: It is advisable to use an isolated USB cable between the PC or laptop and the i3 when third party devices are 
connected to avoid damage to the PC or laptop and/or the Controller. 
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CAN Communications 
Port Description 89 
CAN1 Port Wiring 89  
i3 configurator Programming via CAN 90 
Ladder-Controlled CAN Communication 90 
Using CAN for I/O Expansion (Network I/O) 90 

I3 models provide A CAN network port, which is implemented with 5-pin connectors. The CAN port allows the I3  to 
exchange global data with other I3 controllers and to access remote Network I/O devices .The port also supports 
pass-through communications for programming multiple I3  controllers over the iCAN network. Also, the CAN port 
supports iCAN, CANopen, J1939, and DeviceNet Master (layer 3 as a selectable option). 

Port Description 
The i3 CAN ports implement the ISO 11898-2 physical layer and the CAN 2.0A data link layer standards. Also, 
since the CAN ports are powered by an internal isolated power supply, external CAN power is not required. 

NOTE: The CAN port does not supply power to the network. 

CAN1 Port Wiring 
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I3 configurator Programming via CAN 
The CAN port supports ICAN Programming Protocol. If a PC has a CAN interface installed (via PCI card or USB), 
and the PC CAN port is connected to the i3 CAN port, i3 configurator can access the i3 for programming and 
monitoring. 

In addition, the I3  supports single-point-programming of all i3  devices that are connected to the CAN port net- work. 
If the PC COM port is connected to the I3  MJ1 serial port, the I3  can act as a pass-through gateway allowing i3 
configurator to access all i3 devices that are attached to the CAN port network. 

Ladder-Controlled CAN Communication 
Using Put and Get Network Words function blocks, the CAN1 port can exchange digital and analog global data with other 
devices (nodes) attached to the CAN network. 

In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN network to regularly announce 
their presence and to detect the presence (or absence) of other nodes on the network. 

Using CAN for I/O Expansion (Network I/O) 
Connecting network, I/O devices to the i3 CAN1 port, allows the I3  I/O to be economically expanded and distributed. 
A variety of modules are available for this purpose.
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Ethernet Communications 
 

Ethernet Module Protocols and Features 92 
Ethernet System Requirements 92 
Ethernet Module Specifications 92 
Ethernet Module Configuration 93 
Ethernet Configuration – IP Parameters 96 
Ethernet Module Protocol Configuration 96 

 

 

Ethernet Module Protocols and Features 
The following table describes the Ethernet Module Protocols and features supported by the Ethernet port on an i3  
controller. 

 
Protocol / Feature Protocol / Feature Description 

ICMP (Ping) Internet Control Message Protocol 
EGD Ethernet Global Data 
Modbus Slave Modbus over Ethernet 
Ethernet / IP ODVA CIP over Ethernet 
FTP (File Server) File Transfer Protocol 
ASCII over TCP/IP ASCII Data over Ethernet 

 
 

Ethernet System Requirements 
Full Ethernet functionality requires: 

n PC running i3 Programming Software Version 9.8 or later (for configuration). 
n i3 controller with onboard Ethernet port. 

 
 

Ethernet Module Specifications 
 

Speeds 10 BaseT Ethernet (10Mbps) 100 Base Tx Fast Ethernet (100Mbps) 
Modes Half or Full Duplex 
Auto-Negotiation Both 10/100Mbps and Half/Full Duplex 
Connector Type Shielded RJ-45 
Cable Type 
(Recommended) CAT5 (or better) UTP 

Port Auto MDI/MDI-X (Auto Crossover) 
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Ethernet Module Configuration 
NOTE: The following configuration is required for all applications regardless of the protocols used. Additional con- 
figuration procedures must be performed for each protocol used. 

 
To configure the Ethernet Module, use i3 configurator Programming Software to perform the following steps: 

 
Step 1: On the main i3 configurator screen, select the Controller menu and its Hardware Configuration sub-
menu to open the Hardware Configuration dialog. 

 
 

Step 2: If configuring a different i3 Model than the one shown in the Hardware Configuration dialog, click on the 
Config button, select the desired I3  Model, and then click OK. 
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Step 3: Click the Config button to the right of the LAN1 for LAN 1 or LAN2 for LAN 2, revealing the Ethernet Module 
Configuration dialog. 

 

 
Configure the following: 

 
IP Address: Enter the static IP Address for the Ethernet Module being configured. NOTE: IP Addresses are entered 
as four numbers, each ranging from 0 to 255. These four numbers are called octets, and they are always separated by 
decimal points. See also: "Ethernet Configuration – IP Parameters" on page 96 

 
Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local network. Typical 
local networks use Class C IP Addresses, in which case the low octet (rightmost number) is used to uniquely 
identify each node on the local network. In this case, the default Net Mask value of 255.255.255.0 should be used. 

 
Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication outside of 
the local network. To prevent the Ethernet Module from communicating outside the local network, set the Default 
Gateway IP Address to 0.0.0.0 (the default setting). 
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Status Register: Enter an I3  Register reference (such as %R100) to indicate which 16-bit I3  register will have 
the Ethernet Status word written to it. The table shows how this register value is formatted and explains the 
meaning of each bit in the Status Word. 

 
Ethernet Status Word Register Format 

High Byte Low Byte 
Bit 16 Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 

0 0 Dup Spd 0 Rx Tx Link TCP Connections 

Status Bit Status Indication Status Values 
Minimum Maximum 

0 Reserved Always 0 
Dup Link Duplex (Auto-Negotiated) 0 = Half Duplex 1 = Full Duplex 
Spd Link Speed (Auto-Negotiated) 0 = 10 Mbps 1 = 100 Mbps 
Rx Receive State 0 = Inactive 1 = Active 
Tx Transmit State 0 = Inactive 1 = Active 

Link Link State 0 = Down 1 = Up 
 

TCP Connections 
Total Number of Active TCP Connections 

(iCAN, SRTP, Modbus, Ethernet IP, 
FTP, HTTP) 

 
0 

 
40 

 
Version Register: Enter an i3  Register reference (such as %R101) to indicate which 16-bit i3 register will have the 
Ethernet Firmware Version written to it. The value stored in the Version Register is (Ethernet Firmware Ver sion * 100). 
For example, for Ethernet Firmware Version 4.30, the Version register will contain 430. 

 
Get Setting From: “Get settings from” allows the programmer to either configure the IP Address, Net Mask, or Gateway 
for two functions: Configuration or Register. 

 
Configuration: The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the value in 
the Default Settings in this window. 

 
Register: The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the values in the 
registers assigned. 
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Ethernet Configuration – IP Parameters 
For primary operation, the IP address, Net Mask, and Gateway should be set in the LAN config of the i3 configurator 
Hard- ware Configuration. There are options to get IP parameters from the LAN Config or to get parameters from 
registers. It is possible to set the Ethernet IP parameters from the I3  System Menu, but only as a temporary 
measure. The following points on IP parameter configuration should be considered. 

 
IP Parameters in Non-Volatile RAM: The IP parameters of the i3 configurator LAN Config are written to non-
volatile RAM on power down. IP parameter settings made in the System Menu are not written to non-volatile RAM. 
Any IP parameters settings made in the System Menu will be lost after cycling power to the unit. It will revert to 
the last downloaded i3 configurator LAN Config that was loaded into non-volatile RAM at power down. 

 
“i3 configurator LAN Config”/ “Get Settings from” Configuration: When ‘Get settings from’ is set to 
Configuration, the IP parameters specified under ‘Default Settings’ are used after downloading to the controller. The 
IP parameters are represented in System Menu / Set Networks and can be edited. However, any edits made from 
System Menu / Set Networks is not retained through a power cycle. After the power cycle, the unit reverts to the last 
downloaded i3 configurator LAN Config that was loaded into non-volatile RAM at power down. 

 
“i3 configurator LAN Config” / “Get Settings from” Register: When ‘Get settings from’ is set to Register, the 
IP para- meters are retrieved from the I3  registers assigned in LAN Config. Configured registers must be populated 
with the desired IP parameters: 
 

n The IP parameters are represented in System Menu / Set Networks. 
n The IP parameters cannot be edited from System Menu / Set Networks while the unit is in run mode. 
n The IP parameters always follow the values in the registers unless the I3  unit is placed in idle mode. Then 

the IP parameters can be edited in System Menu / Set Networks. When the I3  is placed back into run 
mode, it reverts to the registers for IP parameters. 

 
 

Ethernet Module Protocol Configuration 
The Protocol Support area contains a list of all the protocols supported by the platform being configured. To activate 
a protocol, check its checkbox. 

 
For protocols that require additional configuration, click on a listed protocol to select it and then click the Configure 
Selected Protocol button. This will open a new dialog with configuration options for the selected protocol. 
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Overview 

Through loadable protocol device drivers, certain models of the i3 family can provide the ability to exchange data    with 
remote devices such as variable-frequency drives, PLCs and remote I/O devices. This feature greatly expands the I3  
’s control capability with negligible effect on the I3  ’s ladder scan time. 

 
Remote devices that communicate serially must do so under certain rules of data transfer known as a protocol. 
Many device manufacturers have created their own protocol for communications with their device. For an i3  to com- 
municate with a specific device, it must be loaded with the corresponding serial communications protocol device 
driver that supports that protocol. 

 
A limited number of protocol device drivers are packaged with the i3 configurator distribution; however, as more are 
developed, they will be made available as add-on packages. A device driver is typically distributed as a Windows 
module, which contains the configuration menus, help files and the target executable driver code. When updating 
device drivers, an install routine loads the device driver to the i3 configurator directory structure and makes that driver 
avail- able to i3 configurator applications. 

 
Once installed, the protocol device driver can be included as part of a i3 configurator  application by selecting it from 
a list of installed protocol device drivers and attaching it to the desired serial port (Home > Protocols). Only one 
protocol device driver can be associated with a serial port, though some I3  models support multiple protocols on a 
single Ethernet port. 

 
Once the protocol is selected for a specific port, that port must be configured to match the bit transfer size and rate of 
the target device(s). This is configured under the Network Config menu, which contains port specific information 
such as the basic serial port parameters (i.e baud rate, stop bits parity, retries, etc.). In addition to the serial port 
parameters, this menu also contains the transaction scan update control configuration and any network level 
protocol specific configuration. 

 
Once the network is configured, each device on the serial communications network must be configured. For some 
forms of communication (i.e.RS232), the network can be limited to one device. The devices are configured under 
the Device Config menu, which contains an arbitrary device name, the device ID and optionally an i3  status register 
that contains any device fault information. 

 
Once each device(s) is configured, a Scan List of entries must be created which defines the transfer of data 
between a local (I3  ) register(s) and a remote device register(s). These entries are created under the Data Map- 
ping menu, which contains an i3  register, a target device ID, a target device register address, the number of 
registers to transfer, and update type. 

 
Each entry can be configured for one of two types of initiating a transaction: Polled and Triggered. Polled type entries 
initiate a transaction with the remote device on every transaction scan. Triggered type entries only initiate a transaction 
when a corresponding local (I3) binary trigger register is set. Once a triggered type of transaction completes, the protocol 
device driver resets the local (I3) binary register to indicate completion. 
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These basic types are also subdivided into read or write operations. For polled operations, a Read operation only 
reads from a remote device. Likewise, a Read/Write operation continuously reads from the remote device unless the 
target i3  register value changes from one ladder scan to another. In this case, the new i3 value is written to the 
target device. For triggered operations, only a read or write action is available. 

When downloaded to the i3,the Scan List is scanned sequentially to generate data transactions with the remote 
device. This transaction scanning can be on a continual basis (automatic) or controlled from ladder logic (manual) 
once a complex connection is created via a program. The specific transaction-scanning mode is selected from the 
Network Config menu. 

Protocol Device Driver Selection 

From the i3 configurator Home > Protocols menu, select the port drop-down box to select a protocol device driver. 
All pro- tocol device drivers currently loaded in i3 configurator are displayed in the drop-down selection along with 
their version numbers. A selected protocol can be removed by selecting None from the drop-down selection. Some 
I3  models can be limited in the number of ports or number of protocol device drivers that can be selected. Once a 
protocol is selected, the Network, Devices and Data (Scan List) must be configured through corresponding dialogues 
accessible through the respective buttons (Network, Devices and Scan List). 
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Network Configuration 
 

Network Configuration provides the required parameters to configure the network. Each protocol is different and 
may not require the entire Network Config field. Please refer to the table below for the options in the Network Config 
field. 
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Network Protocols 
Baud Rate, 
Data Bits, 
Stop Bits, 
Parity 

These field define the bit level transfer over the serial port. 

Handshake 

None – No handshake lines are used. 
Multidrop Full – Rx remains active while Tx is occurring. 
Multidrop Half – Rx is shut off while Tx is occurring. 
Radio Modem – Wait for CTS acknowledgment before transmitting (legacy radio modem support). 

Protocol If a driver supports multiple protocols, it is selected here, (i.e. Modbus supports RTU or ANSI). 
Mode Specifies if port operates in RS232 or RS485 mode. 
Retries Specifies number of times a transaction is retried on a failed response. 
Timeout Specifies the amount of time for a device to wait for a valid response. 

Update 
Scan 

Automatic 

Update Interval – Specifies the update interval at which all 
the mapped entries are executed. 
Reacquire Time – Specifies the amount of time to wait 
before attempting communications with an offline device. 

Manual 

Trigger – Specifies the binary register that a single trans- 
action scan of the Scan List. 

ID Select – If an analog is specified in the field, the ID 
Select filter is enabled. 

Status 
Register 

Specifies the starting i3 register of eight (8) consecutive registers (4-32bit counters), which 
provide an indication of the network health. 

Scanner 
Address Specifies the i3 ’s device (network) ID if a master ID is required by the protocol. 

Protocol 
Help Provides protocol specific help. 
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Device List and Device Configuration 
Device List 

This configuration list is reached from the Device button on the Protocol Config screen and provides a list of the con- 
figured devices on the Network. Devices must be created and exist in this list before corresponding Scan List entries 
can be created for this device. Typically, the number of entries is limited to 128 devices. 

l Add - Opens the Device Config dialog to add a new device to the list.
l Delete - Remove selected device from list (all corresponding Scan List entries are also removed).
l Config - Invoke the Device Config dialog for the currently selected device. This can also be accomplished by

double-clicking a device entry.
l Mapping - Invoke the Scan List limiting the entries displayed for the selected device.
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Device Configuration 

This configuration is reached from the device list when adding or modifying an existing device. While each protocol 
is somewhat different and can contain protocol specific field, all protocols typically support at least: 

l Device Name - Specifies a tag name for this device. This tag name is used in the Data Mapping con- 
figuration to identify this device. This allows device addresses to be modified without the need to update all
associated Data Mapping entries.

l Device ID - Specifies the target device communications ID or station address.
l Swap Words on 32-bit Data - If a Scan List entry is configured to transfer 32-bits and this option is checked,

the high and low 16-bit values are swapped when transferred between the target and I3 .
l Disable Device - From i3 configurator 9.90 SP3 and firmware 15.40 onwards, disable device feature has been

added in protocol device configuration. This option is used to disable a particular slave configured in the net- 
work. Single bit register has to be configured to use this function. Setting the bit high disables, the slave and i3
will not send any serial (TCP for ethernet protocols) packets only to this slave until the bit is high. Set- ting the
bit low enables communication with the slave again.

l Status Enable - This checkbox enables device status to be displayed and controlled from two consecutive
16- bit registers.

l Status Address - Enter the starting 16-bit I3  register of two consecutive registers used for device status.
The first register contains the protocol device driver specific error code while the second register contains the
index of the offending Scan List entry.

l Status Modes:
a. Stop on Error - Specifies that communications be only reattempted after offline status when the

corresponding device status register is cleared.
b. Retry on Error - Specifies that communications be reattempted either during the reacquire interval or

when the corresponding device status register is cleared.
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Scan List 

This configuration list is reached from the Scan List button on the Protocol Config screen or the Mapping button on 
the Device List screen and provides a Scan List of the Data Mapping entries. To transfer data between the I3 and 
remote target, a Scan List must be created that defines each transaction. Each mapping entry (transaction) con- 
tains the source and destination registers, the number of consecutive registers transferred, the direction of the trans- 
fer and what triggers the transfer. Typically, the number of entries is limited to 512. 

NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions are provided to 
change the order of the list. Each entry also has an identifying index. If the device status register is enabled and a 
transaction failure occurs, the status register indicates the index number of the transaction that failed. 
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Menu 
 

l Edit > Copy All - Copies Scan List to clipboard in a tab delimited format suitable for pasting into an applic- 
ation like Microsoft Excel. 

l Edit > Paste - Loads Scan List from clipboard. Pasted items are added to the scan list even if they are duplic- 
ates. 

l View > Toggle All Name View - Expands Scan List such that each point and corresponding local name is 
displayed. 

l Sort Scan List by different criteria. The firmware will scan the devices based on the order they are displayed 
or sorted. There are four ways to sort the scan list: 

a. By Local Address – Sorts the list by local register address in increasing order. 
b. By Target Address – Sorts the list by target register address in increasing order. 
c. By Device Name – Sorts by device name, then target address. 
d. Interleave Devices – This sort evenly distributes requests among the different devices. Instead of 

requesting 100 blocks from device A, then 100 blocks from device B, one request is sent to device A, 
then one request is sent to device B until all the data has been requested. This is useful for devices 
that may have a timeout timer because the time between each scan for a particular device is 
minimized. This sorting option usually doesn’t affect performance. 

 
 

Buttons 
 

l Add - Opens the Data Mapping dialog to add a new entry to the Scan List. 
l Delete - Removes selected entry from Scan List 
l Config - Opens the Data Mapping dialog for the currently selected entry. This can also be accomplished by 

double-clicking an entry. 
l Edit Names - Invokes the Edit Names dialog for the currently selected entry. The Edit Names dialog 

provides the ability to create I3  program names for each point in the transaction. 
 
 

Display Control 
 

Filter by Device - Limits displayed entries to only those assigned to the indicated device. To show all entries select 
–All--. 
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Data Mapping Configuration (Scan List Entry) 

Target 

l Device Name - Selects the target device (by tag name) to use for this transaction. Only those device entries
previously created from the Device Config menu are available.

l Device Register - Specifies the target device’s register to use for this transaction. This designation is target- 
specific. The configuration menu displays an error if a specified address is unacceptable. Generally, the
data type of the local (I3  ) register must match the data type of the device register.

l The Right Arrow button - Displays protocol device driver specific help for the target addressing. Note that
some devices can require register addresses that exist on 8-bit, 16-bit or 32-bit boundaries.

l Local Register - Specifies the local (I3  ) register that is the source or destination for the transaction.
l Local Name [Optional] - Optionally allows selection of an i3 register by name <or> creation of a name for a

register already selected by direct reference. Created names can be used thereafter to specify the local
(I3  ) register in ladder or graphics address fields.

l 32-Bit Access - Allows two local (I3  ) 16-bit registers to be treated as a single 32-bit value. For example,
if the value in either16-bit register is modified, both registers are written to the device. Device-specific, 32-bit
word swapping options also apply to this designation. Since the transaction is treated as a 32-bit access, the
length is generally limited to 16. Note that some protocols can disable this feature.

l Length
a. Specifies the number of consecutive device registers that are transferred in this transaction. Note that

some protocols can limit the length that can be transferred. However, typically the length is limited
to 32. The configuration menu displays an error if a specified length is unacceptable.

b. If allowed, specifying a length greater than one (multiple consecutive register transfers per
transaction) is more efficient than creating a single transaction for each register. This grouping
of registers per transaction can significantly reduce the transaction scan time; however, update types
that include writing on a polled basis require additional consideration.

c. On Read/Write and Read/Write/Init update types, the write transaction only occurs when the local
(I3  ) register value changes. If the length is greater than 1 for Read/Write and Read/Write/Init
types, only the local register(s) that change in value are written. More specifically, only one write
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transaction occurs per scan per mapping entry for the register or consecutive sub-group of local 
registers that changed in value. Depending on the protocol, the number of points written with that 
write transaction are limited either to one or the number of consecutive points that changed value. 

d. Therefore, if several local registers (specified in a single mapping entry) change in value 
prior to a transaction scan, it takes SEVERAL transaction scans to complete all the write 
operations. Furthermore, all write operations are completed before a read operation is 
scheduled. 

e. For Manual Update (transaction) scans (i.e. dialup modem), it is recommended that all 
Read/Write Scan List entry lengths be limited to 1. 

 
 

Update Type 
This field specifies the direction and what triggers the transfer of data between the I3  and target device for a map- 
ping entry. 

l Polled Read - On every transaction scan, a read-only target device register(s) transaction occurs. 
l Polled Read/Write 

a. On every transaction scan, a read target device register transaction occurs unless a local register 
value has changed. The write transaction only updates those local registers that have changed in 
value. If several non-consecutive local registers (contained in a single mapping entry) change value 
between transaction scans, it takes several consecutive transaction scans to write each changed 
register. 

b. When the I3  is placed in RUN mode, the initial action for this mapping type is a read target 
register transaction. This transaction initializes the local (i3) register(s) to match that of the 
remote device register(s). Thereafter, any change to the corresponding i3 register(s) triggers a write 
operation to the remote device. 

l Polled Read/Write/Init 
a. On every transaction scan, a read target device register transaction occurs unless a local register 

value has changed. The write transaction only updates those local registers that have changed in 
value. If several non-consecutive local registers (contained in a single mapping entry) change value 
between transaction scans, it takes several consecutive scans to write each changed register. 

b. When the i3 is placed in RUN mode, the initial action for this mapping type is a write target 
register transaction. This transaction initializes the target device register(s) to match that of the local 
(I3  ) register(s). Thereafter, any change to the corresponding i3 register(s) triggers a write operation to 
the remote device. 

c. The initial write transaction does not occur until after the first logic scan of the i3. This allows 
registers to be initialized locally before Writing to the target device register(s). 

l Triggered Read - A read transaction is triggered by a high level on a separately designated I3  (binary) 
trigger register. Once the read transaction is complete (or the device is offline), the i3 trigger register is 
cleared by the I3  . This update type can be used for occasion data access such as retrieving trend data. Note 
that this operation increases the associated transaction scan time and can cause the Update Interval 
Exceeded Counter to increment on a tightly adjusted update interval. 

l Triggered Write - A write transaction is triggered by a high level on a separately designated I3  (binary) 
trigger register. Once the write transaction is complete (or the device is offline) the i3 trigger register is 
cleared by i3. This function can be used for occasion data access such as sending recipe data. Note that this 
operation increases the associated transaction scan time and can cause the Update Interval Time 
Exceeded Counter to increment on a tightly adjusted update interval. 
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User Interface 
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This chapter presents the user interface (or operator view) of the i3DL and some of the model specific 
characteristics of the i3DL as compared to the rest of the I3  line. This chapter does NOT cover building screens 
or using the i3 configurator graphics editor. For instructions on creating screens and using the graphics editor, 
refer to the Help File in i3 configurator. 

Screen Specifications 
Display Type 10.4” Wide 
Resolution 1024 x 600 pixels 
Backlight LED – 50,000 hours to reach 50% brightness 
Screen Memory 256Kb 
User-Programmable Screens 250 
Keypad Touchscreen 
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Displaying and Entering Data 

Multiple objects are provided for displaying data such as virtual panel lights, push buttons, numeric value displays, 
bar graphs, meters, graphs, and animated bitmaps. On the i3DL, these graphical objects (through ladder 
manipulation of attribute bits) can change color, flash, or change visibility to attract operator attention. 

On objects that accept user input, the input is provided by touching the object or alternately changing an I3  register 
(i.e Function Key Registers). Objects that allow input generally have a raised 3D appearance. An excep tion is the 
binary type objects, such as buttons, which are shown in a depressed 3D appearance when in the ON state. Objects 
that normally accept touch input may be disabled through program control (through ladder manipulation of an attribute 
bit). If an object is disabled, the object’s representation changes to a 2D appearance. 

On objects that represent non-discrete information, more action may be required beyond that of simply touching the object. 
For example, the slider object requires the operator to touch and slide the control in the direction desired. 
Alternately, alpha-numeric entry objects invoke a pop-up alpha-numeric keypad for additional user input. The 
alpha-numeric keypad is discussed below. 

NOTE: If the numeric entry object displays >>>>>>>, the value is too big to display in the field or is above the max- 
imum for an editable field. Likewise, if the numeric entry object displays <<<<<<< in a numeric field, the value is too 
small to display or is below the minimum for an editable field. 
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Numeric keypad 
To allow entry of a specific number, several of the input objects invoke a pop-up numeric keypad when the object is 
touched. An example of the numeric keypad invoked from a numeric input object is shown in Figure 14.2. Once 
invoked, the operator may touch the appropriate keys to enter a specific value. When entering a value, the numeric 
keypad is in one of two modes [new-value or edit-value]. 

New-Value Mode - Generally, when the numeric keypad is first invoked, it is placed in new-value mode. Initially, the 
numeric keypad displays the current value with all the digits being highlighted. Once the first digit is entered, the cur- 
rent value is erased from the display and the new digit is placed in the first location. Thereafter, no digits are high- 
lighted, and new digits are added to the rightmost position while the other digits are shifted left. 

Edit-Value Mode - Edit-value mode may be entered from the initial new-value mode by pressing either the left or 
right arrow key before any digit key is pressed. The result will be a single character highlighted. The user may then 
either touch a key to change the digit at the selected position or the up and down arrows may be used to add or sub- 
tract (respectively) from the selected digit. The user may then use the left or right arrow keys to select a new pos- 
ition. 

Once the desired value is entered, pressing the Enter key moves that value into the object (and the corresponding 
i3 register) and the alpha-numeric keypad disappears. Alternately, pressing the bkey any time before the Enter key 
cancels the operation, leaves the object’s current value unchanged, and the alpha-numeric keypad disappears. 

NOTE: Each numeric entry object has a configured minimum and maximum value. If the operator enters a value out- 
side of the configured range, the new value is ignored when Enter is pressed and the current object value is NOT 
changed. 

Since the alpha-numeric keypad services several different graphical objects, certain keys on the alpha-numeric 
keypad may be disabled (grayed) when the keypad is invoked for certain objects. The following describes the 
alpha-numeric keypad variation based on object. 

Numeric Object - When editing a numeric value, the [+/-] or the [.] key are disabled (grayed) if the object is NOT 
configured for floating-point value or a signed value. 

Password Object - When editing a password value, the arrow keys, [+/-], and the [.] keys are disabled. Addi- 
tionally, overwrite mode is disabled. When entering digits, the pop-up keypad hides the value by displaying ‘*’ altern- 
ately for each digit. 
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ASCII Object - When editing an ASCII value, an ASCII keypad is displayed as shown Figure 14.3. The ASCII 
keypad has three (3) modes, numeric, symbols, and alpha. In Alpha mode, the Caps Lock button may be pressed to 
access capital letters. When you first enter this editor, typing a character will overwrite the entire old string and start 
a new entry. You may press the backspace arrow to delete the previous character. Pressing Enter will save the 
entry, filling any unused space beyond the last character entered with NULL characters. Pressing ESC will cancel 
the edit and return the string to the previous value. 

 

 
 

Text Table Object - When editing a Text Table Object, all of the keys, except the Up and Down arrow keys, are 
grayed and disabled. The next text selection is made by pressing either the Up or Down arrow. 

 
 

Time/Date Object - When editing a Time/Date Table Object, all the keys, except the Up, Down, Left, and Right 
arrow keys, are grayed and disabled. The specific field (i.e. hour or minutes) is selected using the Left and Right 
arrows. The value in the selected field is changed by pressing either the Up or Down arrow. 
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Screen Navigation 
To allow the operator to change screens, a screen jump object is generally used. This object may be visually rep- 
resented as a 3-D button (responding to touch) or remain invisible and logically tied to an i3 register. An optional 
system icon may be configured for display along with the legend, which aids in identifying the object as one that 
causes a screen change, shown below. 

 
Screen jumps can also be triggered on other keys or based on control logic for more advanced applications. To 
allow the operator to change screens, a screen jump object is generally used. This object may be visually rep- 
resented as a button (responding to touch) or remain invisible and logically tied to an I3  register. An optional 
system ICON may be configured for display along with the legend, which aids in identifying the object as one that 
causes a screen change. 

 
 

Ladder Based Screen Navigation 
Ladder logic can use several techniques to control screen navigation. Coils can be tied to %D registers to make 
them screen coils. These coils have two modes: switch and alarm. If the ladder program energizes an alarm display 
coil, the screen associated with this coil is displayed and overrides the normal user screens. This is designed to 
show alarm conditions or to display other ladder-detected events. When the text coil is de-energized, the previous 
screen that was being viewed before the alarm is returned. 

 
The switch display coil switches to the associated screen when it is energized. Once it is de-energized the screen 
remains until it is switched by the user or ladder. 

 

 
There is also a system register that can be used for control-based screen navigation. %SR1 can be read to determine 
the current screen or written to change the current screen. 

 
Refer to the i3 configurator Help file for more information on control-based screen navigation. 
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Touch (Slip) Sensitivity 
Touch slip sensitivity is preset to meet most applications; however, adjustment is available to reduce the sensitivity for 
touch release. That is, once a graphical object (button) is touched and held by a finger, the default touch slip 
sensitivity allows for a slight slip of the finger on the graphical object before the i3DL assumes touch been released 
(equates to approximately a quarter inch of movement with a stylus). 

 
In some applications (such as jog buttons) where the operator is pushing a button for a period of time, the amount of 
slip while holding a button pressed may exceed the default sensitivity. To increase the amount of tolerable slip and 
prevent false releases of the button, the i3DL allows adjustment of the allowable slide up to 5x the default value. 

 
To enable the touch (slip) sensitivity, first an i3 data register must be allocated through the Graphics Editor Con- 
figuration menu for Display Settings. Once a Touch Sensitivity register is assigned, that register may be modified 
[range = 1(Low) to 5 (High)] to the desired slide amount. If a value outside the valid range is entered in the touch 
sensitivity register, it is ignored, and the last valid value is used. 
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Alarms 
Alarm presentation to the operator is highly configurable and beyond the scope of this document to describe fully. 
The alarm object is generally used to enunciate alarms to the operator. Alarm presentation to the operator is highly 
configurable and beyond the scope of this document to describe fully. For more information refer to the graphics 
editor help file in i3 configurator. This section presents a typical configuration thereby providing an introductory 
description of what the operator should expect. 

 
The alarm object is generally used to enunciate alarms to the operator. While the display characteristics of this 
object is configurable, it is generally displayed as a button that changes colors to indicate the highest state of the 
alarm(s) in the alarm group it is monitoring. The following indicates the priority of the alarm states and the default colors 
associated with these states. 
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Alarm Viewer - To view, acknowledge and/or clear alarms, the operator must access the alarm viewer. This is 
accomplished by touching an (enabled) alarm object. When accessed, the alarm viewer is displayed as pop-up 
alarm viewer dialog similar to that shown below. 

 

 
The currently selected entry is indicated by a yellow highlight which can be moved up or down by touching the arrow 
buttons or by directly touching an entry. If more entries exist than can fit on the page, a scroll bar is displayed on the 
right side that also indicates the current relative position. 

 
The current state of the displayed alarm is indicated by its color and optionally by an abbreviated indicator after the 
date/time stamp (ALM, ACK, RTN). The operator can acknowledge an alarm by selecting it from the list and touching 
the ACK button. The operator can also clear an alarm if that function is enabled in the alarm object. If not enabled, 
the Clear buttons are grayed and do not respond to touch. Once view operations are complete, simply touch the 
Esc button to remove the pop-up alarm viewer. 

 
NOTE i3 registers %SR181 and %SR182 are available for ladder use, which indicate presence of 
unacknowledged or acknowledged alarm (respectively). The screen designer may implement these registers to 
switch screens or activate the beeper to attract the operator’s attention. 

 
For more information, refer to the Help file in i3 configurator. 
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Removable Media 
The removable media object is generally used to inform the operator on the current state of the removable media 
device and allow access to its file structure. The removable media object is displayed as a button that changes col- 
ors to indicate the current state of the removable media device. The following indicates the device states and the 
default colors associated with these states. 

 

 
To view and perform file operations, the operator must access the removable viewer. This is accomplished by either 
touching an (enabled) removable media object or through the system menu. When accessed, the removable media 
viewer is displayed as pop-up removable media dialog similar to that shown in the figure below. 

 
NOTE: The removable media object can be configured to open the removable media viewer at a certain directory 
complete with restrictions on transversing back up the file path. This may be used to restrict operator access to non- 
critical files. 

 

 
The currently selected entry is indicated by a yellow highlight which can be moved up or down by touching the arrow 
buttons or by directly touching an entry. If more entries exist than can fit on the page, a scroll bar is displayed on the 
right side that also indicates the current relative position. 

 
File operations are accomplished by pressing the appropriate button at the bottom of the removable media viewer. 
The configuration of the removable media object that invokes the removable media viewer defines what buttons are 
enabled and available to the user. 
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The (Enter) button (if enabled) performs certain operations based on the selected file’s type: 
.. 
<DIR> 

Change display to parent directory Change 
display to child directory 

bmp, jpeg Display bitmap (if compatible format) 
pgm Load application (if compatible model and version) 

 

Alternately, the (enter) button can be configured to simply load the ASCII representation of the file path (including 
the file name) to a group of i3 registers. That pathname can then be used by ladder for opening and manipulating that 
file. 

 
Once view operations are complete, simply touch the Esc button to remove the pop-up removable media viewer. 
It is best practice to discourage removal of removable media devices by the operator while a write operation is in pro- 
cess. This can be accomplished by adding a push button to the screen (tied to %SR174.1), which is used in the 
logic program to lock out write operations prior to media removal. An indicator object (tied to %SR174.2) can also 
be added to the screen, which provides positive confirmation to the operator that it is safe to remove the media. 

 
 

Screen Saver 
The i3DL screen backlight life remains sufficiently bright for five (5) years. It will dim to 70% brightness if it is left on 
continuously for five (5) years. If the application does not require interaction with the i3DL for long periods of time, 
the backlight life can be extended by using the screen saver function. When enabled through the System Menu, the 
backlight is shut off (screen goes black) after a specified time of no activity on the screen. When the screen saver 
shuts off the backlight, any key or button reactivates the backlight. 

 
It is possible for the application to temporarily disable the screen saver by generating a positive transition to 
%SR57.16 (coil only) at a rate faster than the screen saver timeout value. This may be desired while waiting for 
alarm acknowledgement. 

 
NOTE: The backlight life can be extended by dimming or powering off the backlight. 

 
 

Screen Brightness 
The i3DL provides a feature that allows screen dimming for night operation. To enable this feature, the application 
must access and control system register %SR57 (Display Backlight Brightness). Screen brightness is continuously 
variable by driving %SR57 through the range of 100 (full bright) to 0 (full off). It is left to the screen designer on if and 
how to present a Screen Brightness control to the user. 

 
NOTE: Backlight life may be shortened when the screen is dimmed, or screen brightness is varied on a repetitive basis. 
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All IMO controllers’ models provide a Removable Media slot, labeled Memory Card, which supports standard 
microSD flash memory cards. microSD cards can be used to save and load applications, to capture graphics 
screens and to log data for later retrieval. 

microSD Cards 
When the microSD card format was introduced, it was originally called Trans Flash. Cards labeled either microSD or 
Trans Flash, with up to 32GB of flash memory, are compatible with the IMO controller Memory Card slot. 

The Memory Card slot is equipped with a “push-in, push-out” connector and a microSD card can be safely inserted 
into the Memory Card slot whether the IMO controller power is On or Off. 

n To install a microSD card: Align its 8-pin gold edge connector down, facing the front of the IMO controller
unit as shown below; then carefully push it all the way into the Memory Card slot. Ensure that it clicks into
place.

n To remove the microSD card: Push down on the top of the card gently to release the spring. The card pops
up for removal.
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microSD File System 

The microSD Memory Card slot uses the PC-compatible FAT32 File System. This means that a PC, with a 
microSD-compatible card reader, can read files that have been written by the IMO controller and can write files that 
can be read by the IMO controller. 

However, the IMO controller does not support long filenames, but instead implements the 8.3 filename format. This 
means that all file and directory names must consist of up to eight (8) characters, followed by an optional dot, and an 
optional extension with up to three (3) characters. 

Directories and sub-directories can be nested up to 16 levels deep as long as each path name string does not 
exceed 147 characters. 

Using the Removable Media Manager 
The Removable Media Manager is an interactive IMO controller screen that performs the following functions: 

a. Display number of total and free K bytes
b. Browse file and directory lists
c. Delete files and directories
d. Format a microSD card
e. Load and save application programs
f. View screen capture bitmaps

The Removable Media Manager can be accessed via the System Menu or by using i3 configurator to place a 
Removable Media Manager object on an application graphics screen. 

Log Data 
Using Read and Write Removable Media function blocks, an application ladder program can read and write IMO 
controller register data in the form of comma-delimited files, with a .csv extension. These files are compatible with 
standard database and spreadsheet PC programs. In addition, an application ladder program can use Rename and 
Delete Removable Media function blocks to rename and delete files. 
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View and Capture Screens 
The IMO controller File System uses bitmap files with the .BMP extension or JPEG files with the .JPG extension   
to store IMO controller graphic screen captures. 

 
To view a captured IMO controller screen, use the Removable Media Manager to find and highlight the desired 

.BMP or .JPG file, and then press Enter.  
 
 

To capture an IMO controller screen, turning on the assigned Screen Capture Control Register will capture the 
current IMO controller graphics screen and write it to the microSD card using the assigned Screen Capture File- 
name. 

 
Before capturing an IMO controller screen, i3 configurator must first be used to assign a Screen Capture Control 
Register and Filename in the application. To do this, first open the Graphics Editor by selecting the View > Edit 
Screens item on the i3 configurator Screens menu. Next, select the Screen Capture item of the Graphics Editor 
Con- fig menu and then enter a Control Register and Filename. 

 
To capture an IMO controller screen, turning on the assigned Screen Capture Control Register will capture the 
current controller graphics screen and write it to the microSD card using the assigned Screen Capture Filename. 
To view a captured IMO controller screen, use the Removable Media Manager to find and highlight the desired .BMP 
or .JPG file, and then press Enter. 

 
 

Removable Media Object 
The configuration of the Removable Media Object that loads the Removable Media Viewer defines what buttons are 
enabled and available to the user. 

 

The   (Enter) button (if enabled) performs certain operations based on the selected file’s type: 
.. Change display to parent directory 
<DIR> Change display to child directory 
pgm Load application (if compatible model and version) 

 

Alternately, by checking the ‘Write Selected Filename’ option, the RM Manager object will load the currently dis- 
played path and filename into a block of registers for use with other Removable Media functions. The register block 
is assigned in the ‘File Select’ config found in the Config menu of the graphic/screen editor. 

 
Once view operations are complete, simply touch the Esc button to remove the pop-up removable media viewer. 
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Function Blocks in i3 configurator 
NOTE: For detailed information regarding RM function blocks and parameters, refer to the Help File in i3 configurator 
Soft- ware. Refer to ‘USB flash Media support for RM Functions’ for USB flash drive access details. 

 
The following RM functional blocks are available in i3 configurator Software. These function blocks will reference: 

a. microSD when filename is prefixed with ‘A:’ or nothing 
b. USB A flash drive when filename is prefixed with ‘B:’ 

 

Read RM csv Allows reading of a comma-separated value file from the microSD interface into the controller 
register space. 

Write RM csv Allows writing of a comma-separated value file to the microSD interface from the controller 
register space. 

Rename RM 
csv Allows renaming a file on the RM card. The data in the file is not changed. 

Delete RM csv Allows deleting a file on the RM card 
Copy RM csv Allows copying a file on the RM card. The data in the file is not changed. 

 
 

Program Features 
a. Data log Configuration - This feature allows the controller to periodically log register values to 

Removable Media. The register data is stored in .csv (comma separated value) format, which is 
compatible with 3rd party PC applications, such as Microsoft Excel. 

b. Report Editor - This feature allows the i3  to be configured to generate text printouts which incorporate 
data from the registers embedded in the text. The reports can be printed using a serial interface printer through 
any of the serial ports of the I3  or can be saved on the removable media of the device. 

c. Recipes Editor - Recipes allow the user to send or update multiple registers simultaneously. 
 
 

Graphic/Screen Editor 
a. Trends - The historic support feature in the trend object utilizes Removable Media. 
b. Removable Media - This is a graphic object used to access files and functions pertaining to Removable 

Media. 
c. Recipes - This is a graphic object that is used in conjunction with the recipe editor which is mentioned above. 

 
 

Additional Configuration 
a. Alarms - Alarm data can be logged to a .csv file stored on Removable Media. 
b. Screen Capture - The screen capture function allows a bitmap or jpeg image of the displayed I3  screen to 

be written to the Removable Media card. 
c. Filename Counters - The filename counters can be accessed wherever Removable Media functions 

require a path name. A typical application is the auto-incrementing of a file name when doing screen cap- 
tures. 

d. File Select - File Select is used to specify the register block that is used with the Removable Media Manager 
object ‘Write Selected Filename’ option. 
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Filenames 
The RM function blocks support the flash with a Windows standard FAT-16 file system. All names must be limited to 
the “8.3” format where the filename contains eight characters a period then a three-character extension. 

 
The entire filename including any path must be less than or equal to 147 characters. 

 
When creating filenames and directories, it is sometimes desirable to include parts of the current date or time. 
There are six special symbols that can be entered into a filename that are replaced by the I3  with current time and 
date information. 

 
Filename Special Symbols 

Symbol Description Example 
$Y Substitutes the current 2-digit year 2015 = 15 
$M Substitutes the current month with a 2-digit code March = 03 
$D Substitutes the current day 22nd = 22 
$h Substitutes the current hour in 24-hour format 5 pm = 17 
$m Substitutes the current minute 45 = 45 
$s Substitutes the current second 34 = 34 

 
NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, time symbols are in 
lower case. 

 
The following are examples of the substituted time/date filenames: 
Current date and time: March 1, 2015 5:45:34 PM 

 
Filename: Data$M$D.csv = Data0301.csv 
Filename: Year$Y\Month$M\aa$D_$h.csv = Year15\Month03\aa01_17.csv 
Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\17_45_34.csv 

 
 

System Registers used with RM 
%SR174 – Removable Media Protect. Write a one (1) to %SR174 to prohibit read/write access to the removable media 
card. Write a zero (0) to allow access. 
%SR175 Status – This shows the status of the RM interface. 
%SR176 Free Space – This 32-bit register shows the free space on the RM card in bytes. 
%SR178 Card Capacity – This 32-bit register shows the total card capacity in kilobytes. 

Possible status values are shown in the table: 
RM Status Values 

0 RM interface OK 
1 Card present but unknown format 
2 No card in slot 
3 Card present, but not supported 
4 Card swapped before operation was complete 
5 Unknown error 
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Clone Unit 
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‘Clone Unit’ feature allows the user to “clone” the i3  of the exact same model. This feature “clones” application 
program and unit settings stored in battery-backed RAM of an i3  into the RM. Refer to "Removable Media" on 
page 120 for more details. It can then be used to clone a different i3  (exact same model). 

 
This feature can be used for: 

n Replacing an i3 by another unit of the same model. 
n Duplicating or “clone” units without a PC. 

 
 

Make Clone 
The user needs to perform the following to Clone: 

 
Step 1: The ‘Clone Unit’ can be accessed by going to the ‘System Menu’ of the i3 . A new menu “Clone Unit” has 
been added at the end of the main System Menu as shown below: 
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Step 2: Selecting “Make Clone” will open the following menu screen. NOTE: Free/Total – displays number of free and 
total bytes in Removable Media. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Make/Create Clone option enables user to duplicate / Clone application file, all unit settings and all register values 
from battery-backed RAM. Selecting Make Clone brings up the screen below for the user: 

 
Make/Create clone can also be triggered by setting %SR164.9 bit to “1” from Ladder program or graphics. Once the 
operation is completed, this bit is made zero by the firmware. When Make Clone operation is triggered by this SR 
bit, it does not ask the user for confirmation for making clone. The success / failure of the operation is also not notified 
on screen to the user. 

 
In case of failure of “Make Clone” operation, %SR164.11 bit is set to “1” by the firmware and never reset. 

 
NOTE: Backup of registers in flash memory is not performed by Clone Feature. Refer to "Fail-Safe System" on 
page 1. 
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Load Clone 
This option loads the application, all unit settings and register values from Removable media to the battery-backed  RAM 
(Regardless of Auto-Load settings) and then resets the I3  for the settings to take effect. 

 
User needs to perform the following to Load Clone: 
Step 1: Select “Clone Unit” from main System Menu of I3  as shown below: 

 
Step 2: Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

NOTE: For security enabled files, Load clone asks for password validation before loading the application. 
 

Load Clone can also be triggered by setting %SR164.10 bit to “1” from Ladder program or graphics. Once the 
operation is completed, this bit is made zero by the firmware. When Load Clone operation is triggered by this SR bit, 
it does not ask the user for confirmation for loading clone. The success / failure of the operation is also not notified 
on screen to the user. 

 
In case of failure of “Load Clone” operation, %SR164.12 bit is set to “1” by the firmware and never reset. 
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Fail-Safe System 130 
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AutoRun 136 

 
 

For the i3 controllers Series 
The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of 
"soft" failures. These "soft" failures include: 

n Battery power loss 
n Battery-Backed Register RAM or Application flash corruption due to, for example, an excessive EMI, Elec- 

tromagnetic Interference, event. 
 

Fail-Safe System 
The Fail-Safe System has the following capabilities: 

a. Manually backup the current Retentive Register Settings into flash memory. 
b. Manually restore Register Settings from the values previously backed up in flash memory to battery-backed 

RAM. 
c. Detect corrupted Register Settings at power-up and then automatically restore them from flash. 
d. Detect corrupted or empty applications in flash memory at power-up and then automatically load 

the AUTOLOAD.PGM application file from Removable Media (Compact flash or microSD). 
e. If an automatic Register Restore or Application Load occurs, the I3  can automatically be placed in RUN 

mode. 
 

The fail-safe system can be accessed by going to the System Menu of the controller. A new menu “Fail-Safe System” 
has been added at the end of the main System Menu for this. Selecting “Fail-Safe System” menu will open the 
following menu screen: 
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Settings 
To use the Fail-Safe feature, the following steps are required: 

1. From i3 configurator, create AUTOLOAD.PGM for the application program using ‘Export to Removable Media’. 
2. Place the Removable Media with AUTOLOAD.PGM in the device. 
3. Set the ‘Enable Autoload’ option in the device to YES. 
4. Set the ‘Enable Autorun’ option to YES if the controller needs to be placed in RUN mode automatically after 

automatic restore of data or Autoload operation. 
5. Backup the current battery-backed RAM Register contents in onboard flash memory using System Menu 

options. 
 
 

Backup / Restore Data 
Selecting this option brings up a screen having four operations: 

n Backup i3 Data. 
n Restore i3 Data. 
n Clear Backup Data. 
n Exit 

Backup I3 Data 
When initiated, this will allow the user to manually copy battery-backed RAM contents on to the onboard flash 
memory of the i3.This will have the effect of backing up all the registers and controller settings (Network ID, etc.) that 
would otherwise be lost due to a battery failure. 

 
%SR164.4 is set to 1 when backup operation is performed. 
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Restore i3 Data 
When initiated, this will allow the user to manually copy the backed-up data from the onboard flash to the battery- 
backed RAM. 

 
A restore operation will be automatically initiated if 1) a backup has been previously created and 2) on power-up the 
battery-backed RAM registers fail their check. 

 
The following steps are required: 

1. Place the controller in IDLE mode. 
2. Copy data from onboard flash memory to I3  battery-backed RAM 
3. Reset the Controller. 
4. Put the controller in RUN mode if the Autorun setting is ‘Yes’, or else it will remain in IDLE mode. 

 

%SR164.3 is set to 1 only when an automatic restore operation is performed, not on a manual one. This bit is reset 
to the value of “0” when a new backup is created. 

 
Restoring of data can be manually performed by selecting RESTORE option from the Backup / Restore Data menu. 
This will cause the controller to reset. 

 
 

Clear Backup Data 
When initiated, the backup data will be erased from the onboard flash and no backup will exist. %SR164.4 and 
%SR164.3 is reset to 0 when backed up data is erased. 

 
Exit: Goes back to the previous screen. 
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The I3  follows the following sequence in execution of Automatic Restore: 
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AutoLoad 
This System Menu option allows the user to specify whether the i3 automatically loads the application  AUTOLOAD.PGM 
located in Removable Media. 

 
When the AutoLoad setting is enabled (set to YES), it can either be manually initiated or automatically initiated at 
power-up. 

 
The automatic initiation will happen only in the following two cases: 

n When there is no application program in the i3 and a valid AUTOLOAD.PGM is available in the removable 
media of the device. 

n When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM is available in the 
removable media of the device. 

 
 

AutoLoad can be manually initiated when the SYS-F3 key is pressed (i3 can be in any of the following mode – Idle / 
Run / DOIO). This also requires a valid AUTOLOAD.PGM to be present in the removable media of the device. 

 
When the AutoLoad setting is not enabled (set to NO), i3  will be in IDLE mode and the application is not loaded. 

 
If the AUTOLOAD.PGM is security enabled, the user will be prompted to enter the password before loading the 
application. The application will be loaded from the Removable media only after getting the correct password. 

 
%SR164.6 can be set to enable AutoLoad feature. 

 

 
 
Enable AutoLoad 

No = Does not load AUTOLOAD.PGM automatically when application program 
is absent or corrupted. 
Yes = Loads AUTOLOAD.PGM file automatically from Removable Media 
when application program is absent or corrupted. 
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The I3  follows the following sequence in execution of AutoLoad: 
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AutoRun 
This System Menu option, when enabled (YES), allows the user to automatically place the i3  into RUN mode  after 
the AutoLoad operation or automatic Restore Data operation. 

 
When the AutoRun setting is disabled (NO), the i3 remains in the IDLE mode after a Restore Data or AutoLoad 
operation. 

 
%SR164.5 can be set by putting the system into RUN mode automatically, once an AutoLoad has been performed 
or an Automatic Restore has occurred. 

 
If for any reason the AutoLoad-Run (Loading the AUTOLOAD.PGM automatically and I3  put in RUN mode) 
sequence fails, a pop-up message box saying "AUTO-LOAD-RUN SEQUENCE FAILED" will be dis- played. It will 
also show the reason for its failure. On acknowledging this message box, the AutoLoad-Run sequence will be 
terminated, controller will return to the first user-screen and will be placed in IDLE mode. 

 

 

 

“Enable AutoLoad” displays the following options: 

 
Enable AutoLoad 

No = Does not load AUTOLOAD.PGM automatically when application program 
is absent or corrupted. 
Yes = Loads AUTOLOAD.PGM file automatically from Removable Media when 
application program is absent or corrupted. 

No = i3 will be in IDLE mode after AutoLoad or Automatic Restore. 
Yes = i3 will automatically be placed into RUN mode after AutoLoad or Automatic Restore. Enable AutoRun 
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For complete Modbus instructions, please refer to the Help file in the i3 Configurator. 
 

Modbus (serial) is a popular standard protocol that allows industrial devices from multiple manufacturers to easily 
share data in real-time. For Modbus serial communications, the controller can act as either a Master or a Slave. 

 
Modbus protocol (serial) allows for one master and multiple slaves. The master always initiates the conversation by 
sending a request to a particular slave. Only the addressed slave will send a response when the request is 
completed. Should the slave be unable to complete the request, it returns the appropriate error response. Should 
the slave be unable to respond, the master’s timeout timer expires to provide an indication of No Response. 

 
Modbus Slave Overview 
The Modbus slave function block, when used with the appropriate Modem and/or Open Function Blocks, allows the 
primary serial port on the controller to act as a Modbus slave. The Modbus function supports both ASCII and RTU 
modes of operation across a range of baud rates and protocol frames. Also supported is port activity status, an 
inactivity timer, support for call-on exception, and support for store and forward (repeater) operation for radio 
modems. 

 
The Modbus Addressing section describes the supported Modbus Commands as well as the Modbus Map for controller 
references (%R, %M, etc.). 
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Modbus Master Overview 
For complete Modbus Master instructions, please refer to the Help file in the i3 Configurator. 

 
When acting as a Modbus master, there are two primary mechanisms used by the controller to allow the user to 
specify the data to be read/written from/to the slaves. 

 
Modbus Master Function Block—This is for serial only. This is an advanced feature that should only be used 
on                   rare occasions. 
Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box in i3 configurator (serial). 
Refer to the Modbus Addressing section. This is the preferred method in most applications. 

 
After the protocol has been selected from the dropdown menu, the Network, Devices, and Scan List become avail- 
able. The Protocol Config is configured on three different levels: 

n Network—Parameters, such as the polling rate of the data scan, are specified along with timeout values, 
retry, and re-acquisition settings. Serial configuration, baud rate, parity, etc. are also set here. 

n Devices—For every slave to be polled, configuration details are added in the Devices dialog box. This 
includes Slave ID (serial). Under Device Type, the Modbus addressing style matching that specified in the 
slave’s user documentation may be selected. For instance, some slaves specify Modbus addresses (i.e 
40,001), and others specify offsets (i.e. 0000). 

n Hex or Decimal—Some specify addresses in hex, and others in decimal. By allowing the user to 
select the Modbus addressing style for each slave on the network, minimal address conversion is 
required. Also, if the slave is another IMO product (i.e. another i3 ), the “Native Addressing” option 
can be selected (i.e. %R1, %M17, etc.), and this skips the conversion to Modbus style alto- gether. 

n Scan List—This is where the specific Modbus addresses to be read/written from/to each slave are specified. 
Up to 32 words of data can be read at the same time. 

 
NOTE: Once configuration has been completed on the Network and Devices level, Modbus data can be directly 
read/written from graphics objects in the i3 configurator screen editor. This is available even if the Modbus register 
is not listed on the scan list. 
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Modbus Addressing Table 
To access the registers, a Modbus Master must be configured with the appropriate register type and offset. This is usually 
accomplished with one of two methods: 

 
Method 1: The first method uses Traditional Modbus References, in which the high digit represents the register 
type, and the lower digits represent the register offset (starting with Register 1 for each type). Since only four 
register types can be represented in this manner, controller Modbus Function Blocks pack several register types 
into each Modbus register type. Starting addresses of each register type are shown in the Traditional Modbus 
Reference column of the Mobus Table. 

 
Method 2: The second method requires the Modbus Master to be configured with a specific Modbus Command and 
Modbus Offset. The supported Modbus commands and the associated offsets are also illustrated in Modbus Table. 

 
Controller Modbus Master Mapping 

 
Reference Maximum 

Range 

Trad. Modbus Refer- 
ence 

(5 Digits) 

Expanded Modbus 
Ref. 

(6 Digits) 

Modbus Command 
(s) 

Modbus Off- 
set 

%I1 1024 10001 010001  
 
Read Input Status (2) 

0 
%IG1 256 13001 013001 3000 
%S1 256 14001 014001 4000 
%K1 10 15001 015001 5000 

 
%Q1 1024 00001 000001  

Read Coil Status (1) 
Force Coil (5) 
Force Multiple Coils 
(15) 

0 
%M1 1024 03001 003001 3000 
%T1 1024 06001 006001 6000 

%QG1 256 09001 009001 9000 
 

%AI1 256 30001 030001  
Read Input Register 
(4) 

0 
%AIG1 32 33001 033001 3000 
%SR1 200 34001 034001 4000 

 
%AQ1 256 40001 040001  

Read Holding Register 
(3) 
Load Register (6) 
Load Multiple 
Registers (16) 

0 
%R1 2488 40513 040513 512 
%R1 2048 43001 043001 3000 

%AQG1 32 46001 046001 6000 
%R1 5000 -- 410001 10000 
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The Controller products contain field updatable firmware to allow new features to be added to the product. Firm ware 
updates should only be performed when a new feature or correction is required. 

 
WARNING: Firmware updates should only be performed when the equipment being controlled by the I3  is 
in a safe, non-operational state. Communication or hardware failures during the firmware update process 
can cause the controller to behave erratically resulting in injury or equipment damage. Make sure the 
functions of the equipment work properly after a firmware update before returning the device to an 
operational mode. 

 
 

Check for Current Firmware Revision 
To check the firmware revision on a controller, open System Menu > View Status. 
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Firmware Update Details 
NOTE: Updating firmware will clear the application program, screens, configurations, and register data. If required, 
make sure to backup program and register data before updating firmware. The controller’s User Manual has 
instructions for doing backups. 

 
There are two methods for updating firmware. The method used depends on the type of controller being updated. 

 
Method A: Removable Media Method – The controller firmware is updated by a bootloader, using a microSD card 
or USB Flash drive (not through the i3 configurator  Firmware Update Wizard). To update or change firmware: 

1. Download desired Firmware set from the IMO  website. (Verify iCAN or CANopen com- 
munications.) 

2. Save Firmware files to microSD card or USB, these are the removable media devices. 
3. Update the firmware through the controller’s Firmware Update function 

 
NOTE: Files from the IMO website come as a .ZIP file which need to be unzipped and placed in the root of the 
drive for them to function properly. 

 
 

Method B: RS232 Serial Connection – Serial firmware updates are done from i3 configurator software to the 
controller’s primary serial port, MJ1 in most cases. 

 
 
 

Firmware Update Steps 
Unzip all files from the downloaded .zip file onto removable media. 

 
1. Establish communication between i3 configurator and the controller using a direct serial connection to MJ1 or 

USB. 
2. Make sure your application is available on your PC or upload the application. 
3. Make sure the machinery connected to the i3  is in a safe state for firmware update (refer to warning 

above). 
4. Start the firmware update by selecting File > Firmware Update Wizard. 
5. The correct product type should be selected if it is not select the type of controller from the drop-down list. 
6. Press the Start button. 
7. Wait for the firmware update to complete. 
8. If there is a communication failure check the cable, connections and comm. port setting and try again. 
9. Firmware updates typically delete the user applications to ensure compatibility. You will need to reload your 

application. 
10. Test the operation of the equipment with the new firmware before returning the i3  system to an operation 

mode. 
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Preventing Program Loss - An available option to prevent the loss of program should the battery be drained is to 
use the Backup/Restore function which is part of the Fail-Safe System. This feature is highly recommended and is 
accessible from the System Menu and from program logic. Backup/Restore DOES NOT require the installation of a 
microSD card in order to prevent program loss. Refer to "Fail-Safe System" on page 1 for more details. 

 
 
 

Firmware Update via microSD card 
NOTE: Must have Firmware 15.40 or higher in place to be able to update firmware using the microSD card. 

 

Method 1 
Placing “.s19” file in the root of microSD card and loading firmware manually and automatically. 

Manual firmware update by selecting “.s19” file 

Place “.s19” file in the root of microSD card and insert the card. Go to System menu | Removable media and select 
“.s19” file that needs to be loaded. Device displays the following message “Do not power Cycle Until FW is 
updated”, select OK. Firmware update will be started, and a busy symbol will be displayed on the device until firm- 
ware will be loaded. 

 
When firmware update starts %SR154.16 bit will be set to-high. Once the firmware update is completed %SR154.16 
bits will be set to low. 

 
Set %SR154.12 bit to-high before selecting “.s19” file / before loading firmware if user program and register data 
should be cleared after the update. 

 
Set %SR154.12 bit to -low before selecting “.s19” file / before loading firmware if user program should be present, 
register values should be retained and status of the device needs to be retained after the update. 

 
Auto firmware update via %SR’s 

 

Place “.s19” file in the root of microSD card and insert the card. When %SR154.9 is set to high, %SR154.16 bit goes 
high and controller will update the firmware which is placed in the root directory of SD Card. Once the firmware update 
process is successful, %SR154.9 and %SR154.16 bits are reset (goes low). 

 
NOTE: There will be no busy symbol indication for this method. User should monitor %SR’s for the updates. 

Set %SR154.12 bit to-high if user program and register data should be cleared after the firmware update. 

Set %SR154.12 bit to-low if user program should be present, register values should be retained and status of the 
device needs to be retained after the firmware update. 
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Method 2 
Placing “.s19” file in “Update” folder and loading firmware manually and automatically. 

 
For this test, user should create a folder “/Update/Vxxyyzzz” folder in microSD card and then place the “.s19” files 
inside respective folders. 

 
For example - “update/Vxxyyzzz/ xlee.s19” (Where, V is for version and xxyyzzz is the version number, Vxxyyzzz = 
V1549206) 

 
 

NOTES: 
 

a. If the Firmware version on the device and firmware version inside Update folders are same, then nothing 
should happen. 

b. If multiple firmware version folders are available in the update directory, then the version that is greatest / 
latest should get updated to device. 

 
 

Manual Firmware Update via %SR’s 
 

With proper folder structure placed in microSD card, insert the card to device. 
 

Set %SR154.10 high. If the firmware version folder inside update directory is greater than the firmware version on 
the device, then %SR154.16 will go high indicating firmware update process have started. Once the firmware 
update process will be completed, %SR154.10 and %SR154.16 bits goes low. 

 
NOTE: There will be no busy symbol indication for this method. User should monitor %SR’s for the updates. 

Set %SR154.12 bit to-high if user program and register data should be cleared after the update. 

Set %SR154.12 bit to-low if user program should be present, register values should be retained and status of the 
device needs to be retained after the update. 

 
 

Auto firmware update via %SR’s 
 

Setting %SR154.10 and %SR154.11 high, whenever new firmware folder is placed in the microSD card, firmware 
update will happen automatically setting %SR154.16 bit high. Once firmware update process will be completed, 
%SR154.16 bit will be reset but %SR154.10 and %SR154.11 will remain high (for auto update of firmware). 

NOTE: There will be no busy symbol indication for this method. User should monitor %SR’s for the updates. 

Set %SR154.12 bit to-high if user program and register data should be cleared after the update. 

Set %SR154.12 bit to-low if user program should be present, register values should be retained and status of the 
device needs to be retained after the update. 

 
In all the methods, the device will reset automatically after firmware update process is completed. 
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Replacing the Backup Battery 
 

 

Replacing the Backup Battery 
The controller contains a run-time battery monitor that checks the voltage of the internal lithium battery. This battery is 
used to run the real-time clock and maintains retentive registers when power is disconnected. 

 
The battery will generally last seven (7) to ten (10) years. Environmental conditions, including extreme 
temperatures and humidity, can affect battery life. If the battery older than seven (7) to ten (10) years old, it is 
recommended that it be replaced as preventative maintenance. 

 
WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED. 

WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED. 

DO NOT RECHARGE, DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR PUNCTURE. 
 

WARNING: EXPLOSION HAZARD – BATTERIES MUST BE ONLY BE CHANGED IN A AREA KNOWN TO 
BE NON-HAZARDOUS. 

 
WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and local 
regulations. Be sure to consult with the appropriate regulatory agencies before disposing batteries. In 
addi tion, do not recharge, disassemble, heat or incinerate lithium batteries. 

 
WARNING: Do not make substitutions for the battery. Be sure to only use the authorized part number to 
replace the battery. 

 
 

The controller uses a 3V-Lithium coin battery which can be ordered from  

 
Steps to Replace the Battery 

1. Make sure the user program and any data stored in retentive memory is backed up. 
2. Disconnect all power from the controller unit including I/O power. 
3. Remove all connectors, and then use a flat head screwdriver to press and release the four (4) clips. Remove 

the back cover. 
4. Remove the old battery. It may require a small flat blade screwdriver to lift it from the holder. 
5. Dispose of the battery properly; refer to the above warning on disposal regulations. 
6. Slide the new battery into the holder. Make sure the battery is inserted with the proper polarity. The top tab of 

the battery holder should contact the positive (+) terminal of the battery. 
7. Place the back cover over the unit and gently press each corner evenly in order to snap the clips back into 

place. 
8. Apply power to the unit. Check that the battery error is no longer reported. If the unit still reports the 

error, remove the battery immediately and contact IMO. 
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Connecting to the I3  
i3 configurator connects to the local controller automatically when the serial connection is made. The status bar 
below shows an example of a successful connection. This status bar is located in the bottom right-hand corner 
of the i3 configurator window. 

In general, the Target number should match the Local number. The exception to this is when the controller is being 
used as a "pass through" unit where other controllers on an iCAN network could be accessed through the local con- 
troller. See i3 configurator Help File for more details. 

 
Determine connection status by examining feedback next to Local & Target in the status bar of i3 configurator. 

 
I3 configurator Target & Local Numbers 

Local: 
### If a number shows next to Local then communication is established to the local controller. 

Local: 
No Port 

I3 configurator is unable to access the COM port of the PC. This could mean that i3 configurator  is 
configured for a COM port that is not present or that another program has control of the COM port. Only 
one software window can access a port at a time. Subsequent instances of i3 configurator opened will 
indicate No Port. 

Local: 
No Com 

I3 configurator  has accessed a PC COM port but is not communicating with the controller. This typically 
occurs 
when the controller is not physically connected. 

Local: 
??? 

Unknown communication error. Close the i3 software, power cycle the controller and reopen the 
software with a blank project. Check Local. 

Target: 
#(I,R,D) 

If I (idle), R (run), or D (do I/O) shows next to Target number, then communication is established to the 
target controller. 

Target: 
#(?) 

Communication is not established to the target controller. Check node ID of controller and set Target to 
match. Make sure local connection is established. 

 
 

Serial Port – MJ1 Programming 
1. Controller must be powered up. 
2. Ensure that the correct COM port is selected in i3 configurator. Tools > Applications Settings 

> Com munications. 
3. Ensure that a cable with proper pinout is being used between PC and controller port MJ1. 
4. Check that a Loaded Protocol or ladder is not actively using MJ1. Taking the controller out of Run Mode from 

the System Menu on the controller will make MJ1 available to i3 configurator. 
5. Successful communications with USB-to-serial adapters vary. If in doubt, IMO  offers a USB to serial 

adapter: part number  PC501. 
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USB Port - Mini B Programming 
1. Controller must be powered up. 
2. Ensure that the correct COM port is selected in i3 configurator. Tools > Applications Settings 

> Communications. 
3. Be sure that the USB cable is connected between the PC and the controller. Check Windows Device Man- 

ager to ensure that the USB driver is properly installed and to verify the port number. 
 
 

ETN Port Programming 
1. Controller must be powered up. 
2. Ensure that the correct IP address is given in the Ethernet field and correct Mode is selected, in i3 configurator: 

Tools > Applications Settings > Communications. 
3. Ensure that an Ethernet connection has been established by pinging the controller from the Windows DOS 

prompt. 

 
Local Controller and Local I/O 
The System Menu provides the following status indications that are useful for troubleshooting and system maintenance. 
To view the System Menu, press the System key. 

 
n Self-test results, diagnostics. 
n RUN and OK status 
n Network status and usage 
n Average logic scan rate 
n Application memory usage 
n Loaded firmware versions 
n Loaded protocols 
n Removable media access 

 
 

Local I/O Troubleshooting Checklist 
1. Verify the controller is in RUN mode. 
2. Check diagnostics to ensure controller passed self-tests. View Diags in System Menu or in software, 

click Controller/Diagnostics. 
3. Check data sheets to ensure proper wiring. 
4. Ensure that hardware jumpers and software configuration for I/O match. 
5. Check data sheets for voltage and current limits. 
6. Take ladder out of the picture. From i3 configurator set controller to “Do I/O” mode. In this mode inputs can 

be monitored, and outputs set from a data watch window in i3 configurator without interference from the 
ladder program. Some I/O problems are only a result of a mistake in the ladder program. 

 
WARNING: Setting outputs ON in Do I/O mode can result in injury or cause machinery to engage in an 
unsafe manner depending on the application and the environment. 
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ICAN Network 
 

Network status, node ID, errors, and baud rate in the controller System Menu are all in reference to the iCAN net- 
work. These indications can provide performance feedback on the ICAN network and can also be used to aid in 
troubleshooting. 

 
 

ICAN Network Troubleshooting Checklist 
1. Use the proper Belden wire type or equivalent for the network as specified in the CAN Networks Manual 
2. The i3  does not provide 24VDC to the network. An external voltage source must be used for other 

devices such as  XCL-BSSA. 
3. Check voltage at both ends of the network to ensure that voltage meets specifications of attached devices. 
4. Proper termination is required. Use 121Ω (or 120Ω) resistors at each end of the network. The resistors 

should be placed across the CAN_HI and CAN_LO terminals. 
5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and terminated, 

there should be around 60Ω. 
6. Check for duplicate node ID’s. 
7. Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used for CAN_HI 

and CAN_LO. 
8. Make sure the baud rate is the same for all controllers on the network. 
9. Assure shields are connected at one end of each segment—they are not continuous through the network. 

10. Do not exceed the maximum length determined by the baud rate and cable type. 
11. Total drop length for each drop should not exceed 6m (20’). A drop may include more than one node. The 

drop length adds to the overall network length. 
12. Network should be wired in "straight line" fashion, not in a "star" pattern. 
13. In applications requiring multiple power supplies, make sure the V- of all supplies is connected and to earth 

ground at one place only. 
14. In some electrically noisy environments, it may be necessary to add repeaters to the network. Repeaters can 

be used to add additional nodes and/or distance to the network and protect the signal against noisy 
environments. 

 
 

USB Interfaces 
n Plugging and unplugging USB devices while the i3  is powered up can cause the I3  to reset. In general, 

branded USB memory sticks will not cause this problem, however, with the advent of USB 3.0 and larger / 
faster memory devices this cannot be guaranteed. 

n Larger USB devices such as hard-drives etc. should only be attached and removed when the i3  is 
powered down. 

n The resets are caused by short sharp current spikes when devices are added or removed from the I3 , 
these spikes can exceed the USB specification but are usually very short and mostly do not cause problems. 
Some devices, however, draw a longer larger current as they power up causing a brief dip in the i3 internal 
supplies leading to a reset. 

n Standard SanDisk and Kingston ranges with read times less than 120MB/sec. should not cause resets. 
The display will flicker when a device is added or removed. 
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Basic Troubleshooting 
 

Description Action 
i3  does not 
read media card. The media card should be formatted with the controller. 

i3  will not 
download project 
file. 

Make sure the project file is saved as a .pgm file and not a .csp file. In addition, the file must 
be .pgm. The file's I/O configuration must match the controller configuration for it to 
download. 

 
 

Technical Support Contacts 
For manual updates and assistance, contact Technical Support at the following locations: 

 
 
 

Technical Support: 
Tel: +44 (0) 1707 414 444 
Website: www.imopc.com 
Email: automation@imopc.com
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I3DL Change Log 
 

Date Rev # Description of Revision Location in Doc 
 
 
 

8/16/2021 

 
 
 

8 

Reordered Chapters (Mantis 3029) 
Updated Install Procedure (6482) 
#4845 – Updated i3RMI register #4802 
– i3RMI – Max # of connections #3573 – 
Added new J3 Wiring images #5381 – 
Load FW via microSD card 

Throughout 
Install Procedure 
System Register Table 
Ethernet Overview 
RTD Wiring 
Firmware Update 

4/14/22 8.1 #7588 – Note about %SR 
#7591 – LED Status Info 

%SR Table 
System Menu 

7/22/22 8.2 #7635- HSC Pulse Output Info HSC Pulse Output 
1/26/23 20 Converted to Madcap Flare Throughout 
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